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I Management and Monitoring Services

If Novell® ZENworks® for Servers (ZfS) 3.0.2 Management and Monitoring Services displays an 
error message, you can look it up in the Error Messages section. If a problem is not accompanied 
by an error message, or if specific instructions for an error message are not available, you can try 
more general troubleshooting strategies to resolve the problem.

This section contains the following topics: 

Chapter 1, “Error Messages,” on page 13

Chapter 2, “Troubleshooting Strategies,” on page 59

Chapter 3, “Documentation Updates,” on page 79
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1 Error Messages

The following sections contain explanations of the error messages you might encounter while 
using Novell® ZENworks® for Servers (ZfS) 3.0.2 Management and Monitoring Services: 

“Discovery Error Messages” on page 13

“Management and Monitoring Services Database Error Messages” on page 19

“Atlas Manager Error Messages” on page 20

“Service Manager Error Messages” on page 22

“MIB Compiler Error Messages” on page 22

“Traffic Analysis Error Messages” on page 44

“Traffic Analysis Agent for NetWare Error Messages” on page 51

“Traffic Analysis Agent for Windows NT Error Messages” on page 55

“Management and Monitoring Services Reports Error Messages” on page 57

Discovery Error Messages
NetExplorer: Warning: The available disk space on volume volume_name is only 'x' byte(s)
NetExplorer: Warning: The available disk space on volume volume_name is less than 2 blocks
Unable to remove files: datfilename with path. You need to manually remove the files from the 

directory. Restart discovery
Unable to remove NetExplorer .DAT files in 

zfs_install_volume:\zfs_install_folder\ZENWORKS\MMS\MWSERVER\NMDISK\DAT
The server does not contain an IP or IPX address. You need to specify an IP or an IPX address. 

Restart discovery
Unable to load the NXPIP.NLM file. An IP address is not bound to any of the interfaces. Specify 

an IP address and restart discovery
Waiting for Netxplor.nlm to load
Unable to open IPCache. Please check to see if the following .DDF files exist on the server: 

ATTRIB.DDF, FIELD.DDF, FILE.DDF, NDEX.DDF
DiscoverNodesInFile :: Input file DiscNodes.txt not found
DiscoverNodesInFile :: To use File-Based Discovery, you can create a new input file
Unable to find the DNS name server information in the RESOLV.CFG file. Ensure the DNS server 

is configured correctly
Unable to update the NetExplorer configuration file
Insufficient memory. Exit NetExplorer and try later
Changes cannot be activated from here. Reload NetExplorer to activate the changes in the 

following: changelist
Error starting Naming Service. Naming Service already running on port portnumber
Error starting Naming Service. The address is already in use
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NetExplorer: Warning: The available disk space on volume volume_name is only 'x' byte(s)

Source: ZENworks for Servers; Management and Monitoring Services; NETXPLOR.NLM

Severity: Warning

Explanation: The volume where the ZfS server is installed does not have sufficient memory.

Action: Delete unnecessary files to free up memory.

NetExplorer: Warning: The available disk space on volume volume_name is less than 2 blocks

Source: ZENworks for Servers; Management and Monitoring Services; NETXPLOR.NLM

Severity: Warning

Explanation: The volume where the ZfS server is installed does not have sufficient memory.

Action: Delete unnecessary files to free up memory.

Unable to remove files: datfilename with path. You need to manually remove the files from the 
directory. Restart discovery

Source: ZENworks for Servers; Management and Monitoring Services; NETXPLOR.NLM

Severity: Critical

Explanation: The NetExplorerTM server was unable to remove the .DAT files created during the early cycles of 
discovery.

Possible Cause: ZfS services were started using the sloader.ncf command before starting discovery NLMTM 
software (NETXPLOR.NCF).

Possible Cause: Discovery was stopped and started without stopping the ZfS services.

Action: You need to perform the following tasks: 

1 Stop the discovery services. 

To stop the discovery services, enter stopdis.ncf at the Management server prompt.

The Consolidator, SN3 discovery, and Bridge discovery services will stop. 

Wait until these services are completely stopped.

2 Start NetExplorer.

3 Start the discovery services. 

To start the discovery services, enter startdis.ncf.

Unable to remove NetExplorer .DAT files in 
zfs_install_volume:\zfs_install_folder\ZENWORKS\MMS\MWSERVER\NMDISK\DAT 

Source: ZENworks for Servers; Management and Monitoring Services; NETXPLOR.NLM

Severity: Critical

Explanation: The NetExplorerTM server was unable to remove the .DAT files created during the early cycles of 
discovery.

Possible Cause: ZfS services were started using the sloader.ncf command before starting discovery NLMTM 
software (NETXPLOR.NCF).

Possible Cause: Discovery was stopped and started without stopping the ZfS services.
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Action: You need to perform the following tasks: 

1 Stop the discovery services. 

To stop the discovery services, enter stopdis.ncf at the Management server prompt.

The Consolidator, SN3 discovery, and Bridge discovery services will stop. 

Wait until these services are completely stopped.

2 Start NetExplorer.

3 Start the discovery services. 

To start the discovery services, enter startdis.ncf.

The server does not contain an IP or IPX address. You need to specify an IP or an IPX address. Restart 
discovery

Source: ZENworks for Servers; Management and Monitoring Services; NetExplorer

Severity: Critical

Explanation: Discovery was unable to obtain a valid IP/IPXTM binding on the local host.

Possible Cause: The IP/IPX address is not bound to any interfaces of the machine.

Action: Verify that TCP/IP and/or SPXTM/IPX stacks are configured correctly. Ensure that the IP and/or 
IPX address is bound to an interface.

Unable to load the NXPIP.NLM file. An IP address is not bound to any of the interfaces. Specify an IP 
address and restart discovery

Source: ZENworks for Servers; Management and Monitoring Services; NXPIP.NLM

Severity: Critical

Explanation: The NXPIP.NLM was unable to obtain the IP address of the local host.

Possible Cause: An IP address is not bound on this machine.TCP/IP is not configured on this machine.

Action: Verify that a valid IP address is bound to an interface and TCP/IP is configured correctly.

Waiting for Netxplor.nlm to load

Source: ZENworks for Servers; Management and Monitoring Services; NXPIP.NLM, NXPLANZ.NLM

Severity: Critical

Explanation: NetExplorer server is unable remove the .DAT files created by earlier cycles of discovery.

Possible Cause: Failure to initialize the NetExplorer server. 

Action: You need to perform the following tasks: 

1 Stop the discovery services. 

To stop the services, enter stopdis.ncf at the Management server prompt.

The Consolidator, SN3 discovery, and Bridge discovery services will stop. 

Wait until these services are completely stopped.

2 Start NetExplorer.

3 Start the discovery services.

To start the discovery services, enter startdis.ncf.
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Unable to open IPCache. Please check to see if the following .DDF files exist on the server: 
ATTRIB.DDF, FIELD.DDF, FILE.DDF, NDEX.DDF

Source: ZENworks for Servers; Management and Monitoring Services; IPGROPER.NLM, 
NXPLANZ.NLM

Severity: Critical

Explanation: An error occurred while opening IPCACHE. The discovery NLM programs were loaded in the 
wrong sequence. In NETXPLOR.NCF, the NXPIP.NLM must be loaded before 
IPGROPER.NLM and NXPLANZ.NLM.

Possible Cause: NETXPLOR.NCF has been manually edited.

Action: You need to perform the following tasks:

1 Copy the NETXPLOR.NCF and NXP.INI files from the ZENworks for Servers product CD to 
the following directory: installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\
NMDISK.

2 Edit the NXP.INI file with the following: [IPCACHE] PATH = 
installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\
NMDISK\IPCACHE\

3 Restart discovery.

Possible Cause: The NXP.INI file is corrupted and does not have the [IPCACHE]section.

Action: You need to perform the following tasks:

1 Copy the NXP.INI file from the ZENworks for Servers product CD into the following 
directory: installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\
NMDISK.

2 Edit the NXP.INI file with the following: [IPCACHE] PATH = 
installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\
NMDISK\IPCACHE\

3 Restart discovery.

DiscoverNodesInFile :: Input file DiscNodes.txt not found

Source: ZENworks for Servers; Management and Monitoring Services; IPGROPER.NLM

Severity: Informational

Explanation: File-based discovery has been configured to run without specifying an input file.

Possible Cause: The input file has not been configured. 

Action: If you want to discover hosts using file-based discovery, create the DISCNODES.TXT input file 
and place it in the ZFS-INSTALL-DIR/MWSERVER/NMDISK directory. For more information, 
see “File-Based Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

DiscoverNodesInFile :: To use File-Based Discovery, you can create a new input file

Source: ZENworks for Servers; Management and Monitoring Services; IPGROPER.NLM

Severity: Informational

Explanation: File-based discovery has been configured to run without specifying an input file.

Possible Cause: The input file has not been configured. 
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Action: If you want to discover hosts using file-based discovery, create the DISCNODES.TXT input file 
and place it in the ZFS-INSTALL-DIR/MWSERVER/NMDISK directory. For more information, 
see “File-Based Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Unable to find the DNS name server information in the RESOLV.CFG file. Ensure the DNS server is 
configured correctly

Source: ZENworks for Servers; Management and Monitoring Services; IPGROPER.NLM

Severity: Important

Explanation: The SYS:\ETC\RESOLVE.CFG file does not contain the information on the DNS server to be 
queried to retrieve the DNS names.

Possible Cause: The server has not been configured with any DNS server to resolve names.

Action: Configure the NetWare® server to query a DNS server.

Action: You can also manually edit the RESOLVE.CFG file to create an entry for the DNS server. For 
example: domain domainname nameserver IP address of the DNS server.

Unable to update the NetExplorer configuration file

Source: ZENworks for Servers; Management and Monitoring Services; NXPCON.NLM

Severity: Critical

Explanation: The configuration that needs to be updated in the NXP.INI configuration file in the 
installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\NMDISK directory could not 
be performed.

Possible Cause: The NXP.INI file is corrupted or does not exist.

Action: You need to perform the following tasks:

1 Stop NetExplorer.

To stop NetExplorer, enter unexp at the Management server prompt.

2 If sloader is started, stop the Java* discovery processes. 

To stop the discovery processes, enter stopdis.

Wait for all the Java discovery processes to stop.

3 Copy the NXP.INI file from the ZENworks for Servers product CD into the following 
directory: installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\NMDISK.

4 Edit the NXP.INI file with the following entry: [IPCACHE] PATH = 
installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\NMDISK\IPCACHE\

5 Start NetExplorer. 

To start NetExplorer, enter netxplor at the Management server prompt.

6 Start the Java discovery processes.

To start the processes, enter startdis.

Use NXPCON to configure NetExplorer.
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Insufficient memory. Exit NetExplorer and try later

Source: ZENworks for Servers; Management and Monitoring Services; NXPCON.NLM

Severity: Critical

Explanation: The program was unable to allocate sufficient memory.

Possible Cause: The server is running low on memory.

Action: Check and unload unnecessary processes to free up the memory and try again.

Changes cannot be activated from here. Reload NetExplorer to activate the changes in the following: 
changelist

Source: ZENworks for Servers; Management and Monitoring Services; NXPCON.NLM

Severity: Informational

Explanation: You have changed certain configuration parameters like the IP discovery scope, which require the 
NetExplorer system to be restarted. These changes cannot be updated within the NetExplorer 
system while the other modules are running.

Possible Cause: You have made the changes to suboptions other than SNMP using Configuration Options.

Action: You need to perform the following tasks:

1 Stop NetExplorer.

To stop NetExplorer, enter unxp at the Management server prompt.

2 If sloader has been started, stop the Java discovery processes. 

To stop the Java discover processes, enter stopdis. 

Wait for all the Java discovery processes to stop.

3 Start NetExplorer.

To start NetExplorer, enter netxplor.

4 Start the discovery processes.

To start the discovery process, enter startdis.

Error starting Naming Service. Naming Service already running on port portnumber

Source: ZENworks for Servers; Management and Monitoring Services; Naming Server

Severity: Informational

Explanation: A prior instance of the Naming Server Java process is already running and an attempt was made 
to start it again.

Possible Cause: You have entered mwserver twice at the command prompt.

Possible Cause: You have attempted to restart the services without killing the Naming Server Java process.

Action: You need to perform the following tasks:

1 Stop the Naming Server Java process.

To stop the Naming Server Java process, enter mmsNaming -exit.

2 Restart the Naming Server Java process.

To restart the Naming Server, enter mwserver.
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Error starting Naming Service. The address is already in use

Source: ZENworks for Servers; Management and Monitoring Services; Naming Server

Severity: Important

Explanation: The NetWare server has not released the port associated with a prior instance of the Naming Server 
Java process. Therefore, a subsequent attempt to restart the Naming Server on the same port 
failed.

Possible Cause: An attempt to stop and start the Naming Server Java process was made too quickly.

Action: Wait for a longer time interval (at least a minute) before restarting the Naming Server Java process.

Management and Monitoring Services Database Error Messages
An error occurred while connecting to the database
An error occurred during database backup
An error occurred while updating the database
An error occurred while updating NDS

An error occurred while connecting to the database

Source: ZENworks for Servers; Management and Monitoring Services; Change Database Password Snap-
In and Database Backup Snap-In at the Properties page at the site server level

Severity: Critical

Explanation: Connection to the database could not be established.

Possible Cause: The database may be down.

Action: Check whether the database is down. If the database is down, you need to bring up the database.

To bring up the database, enter mgmtdbs at the Management server prompt.

An error occurred during database backup

Source: ZENworks for Servers; Management and Monitoring Services; Database Backup Snap-In at the 
Properties page at the site server level

Severity: Important

Explanation: The database backup operation could not be performed.

Possible Cause: The database may be down.

Action: Check whether the database is down. If the database is down, you must bring up the database.

To bring up the database, enter mgmtdbs  at the Management server prompt.

An error occurred while updating the database

Source: ZENworks for Servers; Management and Monitoring Services; Change Database Password Snap-
In at the Properties page at the site server level

Severity: Important

Explanation: The password for the database could not be changed.

Possible Cause: The database may be down.
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Action: Check whether the database is down. If the database is down, you must bring up the database.

To bring up the database, enter mgmtdbs at the Management server prompt.

An error occurred while updating NDS

Source: ZENworks for Servers; Management and Monitoring Services; Change Database Password Snap 
In at the Properties page at the site server level

Severity: Important

Explanation: When you attempted to change the database password, Novell eDirectoryTM could not be updated 
with the new password.

Possible Cause: There is a problem with eDirectory.

Action: Check the eDirectory error code to see what the problem is. If you are unable to resolve the error, 
copy the exception stack trace and report it to Novell Technical ServicesSM (http://
support.novell.com).

Atlas Manager Error Messages
An error occurred while retrieving objects from the server. Ensure that Atlas Manager is running 

at the server, and refresh the ZfS sites to see the view again
Could not connect to Atlas Manager at IP_address

An error occurred while retrieving objects from the server. Ensure that Atlas Manager is running at the 
server, and refresh the ZfS sites to see the view again

Source: ZENworks for Servers; Management and Monitoring Services; Atlas Manager

Possible Cause: Atlas Manager is not running at the ZfS server.

Action: Check if Atlas Manager is running. To check, you need to perform the following tasks: 

1 Check the log files generated in the following directory: 
installvolume:\installdirectory\ZENWORKS\MMS\LOGFILES\ SLOADER. 

2 Select the SLOADER-bignumber.TXT file which contains the latest modified time stamp.

3 Search for the following string:

AtlasManager:CmdServerObjThread.java 
:com.novell.managewise.AtlasCmdServerObj[XXXXX] is ready.

(XXXXX will be replaced by some detailed information in the file.)

If this string does not exist, you may need to wait for about 4-5 minutes for the services to 
start. If they do not start automatically, you need to restart them. 

Possible Cause: The ZfS server processes were stopped and restarted when the ConsoleOne®  was running.

Action: You need to perform the following tasks:

1 From ConsoleOne, select ZfS Site. 

2 Click Refresh.

If the error message persists, close the ConsoleOne session that is currently running. Launch 
ConsoleOne again. 

Possible Cause: The ConsoleOne snap-in and the site server have different ZfS versions.
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Action: You need to perform the following tasks:

1 Ensure that the ConsoleOne snap-in and the site server are using the same ZfS version. The 
ZfS 2 snap-ins do not work with the ZfS 3.0.2 site server, and vice versa.

2 Install the latest ZfS version of the snap-ins on the console and the latest version of the site 
server on the server and restart the processes.

Could not connect to Atlas Manager at IP_address

Source: ZENworks for Servers; Management and Monitoring Services; Atlas Manager

Possible Cause: Atlas Manager is not running at the ZfS server.

Action: Check if Atlas Manager is running. To check, you need to perform the following tasks: 

1 Check the log files generated in the following directory: 
installvolume:\installdirectory\ZENWORKS\MMS\LOGFILES\ SLOADER. 

2 Select the SLOADER-bignumber.TXT file, which contains the latest modified time stamp.

3 Search for the following string:

AtlasManager:CmdServerObjThread.java:com.novell.managewise.Atlas
CmdServerObj[XXXXX] is ready.

(XXXXX will be replaced by some detailed information in the file). 

If this string does not exist, you may need to wait for about 4-5 minutes for the services to 
start. If they do not start automatically, you need to restart them. 

Possible Cause: The ZfS server processes were stopped and restarted when ConsoleOne was running.

Action: You need to perform the following tasks:

1 From ConsoleOne, select the ZfS site. 

2 Click Refresh.

If the error message persists to display, close the ConsoleOne session that is currently running. 
Launch ConsoleOne again. 

Possible Cause: The ConsoleOne version and the site server are of different ZfS versions.

Action: You need to perform the following tasks:

1 Ensure that the ConsoleOne snap-in and the site server are of the same ZfS version. The ZfS-
2 snap-ins do not work with ZfS-3 site server, and vice versa.

2 Install the latest ZfS version on the console and the server and restart the processes.
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Service Manager Error Messages
Unable to obtain Naming Server Instance
Service Manager is already running

Unable to obtain Naming Server Instance

Source: ZENworks for Servers; Management and Monitoring Services; SLOADER or NetExplorer

Severity: Critical

Possible Cause: The service loader was started while the Naming Server was not running.

Action: Start the Naming Server. 

To start the Naming Server, enter mmsnaming at the Management server prompt. You need not 
restart the service loader because it will locate the Naming Server after a short interval.

Service Manager is already running

Source: ZENworks for Servers; Management and Monitoring Services; SLOADER or NetExplorer

Explanation: Management and Monitoring Services does not allow you to run multiple instances of the same 
Service Manager. 

Possible Cause: You may be trying to run the service manager even if an instance of the service manager is not 
actually running. This happens when the earlier instance of service manager is closed using java 
-kill instead of stopservice. 

Action: Restart the Naming Server by closing the Naming Server and starting the Naming Server again.

To restart the Naming Server, enter mmsNaming. 

MIB Compiler Error Messages
MIBCERR102: Badly constructed INDEX clause. The syntax should be INDEX {object name}
MIBCERR103: Unknown to parse the value for an unknown or aggregate type. Check the spelling 

and the format.
MIBCERR104: Duplicate number the named number list
MIBCERR105: Incorrect syntax: Expected '(', read
MIBCERR106: Incorrect syntax: Expected ')', read
MIBCERR107: Incorrect syntax: Expected ',' or '}'
MIBCERR108: Incorrect syntax: Expected '{' after DEFVAL
MIBCERR109: Incorrect syntax: Expected '{' after VARIABLES
MIBCERR110: Incorrect syntax: Expected '{', read
MIBCERR111: Incorrect syntax: Expected a non-negative integer
MIBCERR112: Incorrect syntax: Expected a type
MIBCERR113: Incorrect syntax: Expected an integer
MIBCERR114: Incorrect syntax: Expected an octet string
MIBCERR115: Incorrect syntax: Expected a filename after HELP
MIBCERR116: Incorrect syntax: Expected HELPTAG number after #HELPTAG
MIBCERR117: Incorrect syntax: Expected identifier after ACCESS
MIBCERR118: Incorrect syntax: Expected identifier after STATUS
MIBCERR119: Incorrect syntax: Expected identifier
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MIBCERR120: Incorrect syntax: Expected index object or index type
MIBCERR121: Incorrect syntax: Expected module reference
MIBCERR122: Incorrect syntax: Expected number
MIBCERR123: Incorrect syntax: Expected a string after DESCRIPTION
MIBCERR124: Incorrect syntax: Expected string after REFERENCE
MIBCERR125: Incorrect trap annotation: Expected string after SUMMARY
MIBCERR126: Incorrect trap annotation: Expected string after TYPE
MIBCERR127: Incorrect trap annotation: Expected time index number after \#TIMEINDEX
MIBCERR128: Incorrect syntax: In INDEX clause: Expected ... , INTEGER OPTIONAL
MIBCERR129: Incorrect syntax: Expected ::=
MIBCERR130: Incorrect syntax: Expected ACCESS
MIBCERR131: Incorrect syntax: Expected BEGIN
MIBCERR132: Incorrect syntax: Expected DEFINITIONS
MIBCERR133: Incorrect syntax: Expected ENTERPRISE
MIBCERR134: Incorrect syntax: Expected HELPTAG item after HELP
MIBCERR135: Incorrect syntax: Expected NULL
MIBCERR136: Incorrect syntax: Expected identifier after STATUS
MIBCERR137: Incorrect syntax: Expected SYNTAX
MIBCERR138: Incorrect syntax: Expected ',' or FROM
MIBCERR139: Incorrect syntax: Import clause: Expected symbol
MIBCERR140: Illegal type in IndexPart
MIBCERR141: Out of memory
MIBCERR142: Premature end of file encountered. HINT: Check for premature truncation of file 

(%s)
MIBCERR143: A syntax error encountered in the object ID
MIBCERR144: Token too large
MIBCERR147: Incorrect alarm trap annotation: Too many arguments after ARGUMENTS.
MIBCERR148: Undefined identifier
MIBCERR149: Undefined type
MIBCERR150: Undefined IMPORTS:
MIBCERR151: Redefinition of
MIBCERR152: Unexpected term
MIBCERR153: Invalid token
MIBCERR154: Unexpected type after SEQUENCE OF
MIBCERR155: Unrecognized ASN.1 type after SYNTAX
MIBCERR156: Unrecognized value for SEVERITY
MIBCERR157: Print operation cancelled, either due to operator cancel or operation cannot be 

completed
MIBCERR158: Incorrect syntax: Expected a string after DISPLAY-HINT
MIBCERR201: Incorrect syntax: Expected a string after UNITS
MIBCERR205: Incorrect syntax: Expected OBJECTS
MIBCERR212: Incorrect syntax: Expected LAST-UPDATED
MIBCERR213: Incorrect syntax: Expected a string after LAST-UPDATED
MIBCERR214: Incorrect syntax: Expected ORGANIZATION
MIBCERR215: Incorrect syntax: Expected string after ORGANIZATION
MIBCERR216: Incorrect syntax: Expected a string after CONTACT-INFO
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MIBCERR217: Incorrect syntax: Expected a string after REVISION
MIBCERR218: Incorrect syntax: Expected CONTACT-INFO
MIBCERR219: Incorrect syntax: Expected DESCRIPTION
MIBCERR221: Incorrect sequence adopted to define trap annotation. Correct sequence is: TYPE, 

SUMMARY, ARGUMENTS, SEVERITY, TIMEINDEX, HELP, HELPTAG and STATE
MIBCERR226: Incorrect Syntax: Expected identifier after OBJECTS
MIBCERR227: Incorrect syntax: Expected NOTIFICATIONS
MIBCERR228: Incorrect syntax: Expected identifier after NOTIFICATIONS
MIBCWAR001: Unrecognized ACCESS type
MIBCWAR002: Unrecognized STATUS type
MIBCWAR003: Ignoring named number > 32767
MIBCWAR004: Trap(s) missing supplemental NMS annotation

MIBCERR102: Badly constructed INDEX clause. The syntax should be INDEX {object name} 

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Possible Cause: The syntax in the INDEX clause is incorrect. 

Action: Check the syntax of the INDEX clause. 

The required syntax for the INDEX clause is: 

INDEX List of ObjectNames

The list of object names should be separated by commas. 

For example,  

nwUserVolUsageEntry OBJECT-TYPE 

INDEX nwUserVolUserID, nwUserVolVolID

The object names in this example are nwUserVolUserID and nwUserVolVolID.

MIBCERR103: Unknown to parse the value for an unknown or aggregate type. Check the spelling and 
the format.

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The MIB Compiler attempts to understand a value through the type that is referenced. If that type 
is not known, the MIB Compiler cannot interpret the value.

Possible Cause: The type is unknown and the MIB Compiler cannot interpret the value.

Action: Make sure the spelling and format of the type are correct. 

Action: Delete any invalid non-white-space characters (characters other than the white space characters 
such as tab or space).

MIBCERR104: Duplicate number the named number list

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The named number lists contain elements consisting of a label and an associated number. The 
labels provide meaning to the assigned numbers. The numbers must be unique in a named number 
list.

Possible Cause: The same number has been incorrectly assigned to multiple list entries.

Action: Ensure that the numbers are unique.
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MIBCERR105: Incorrect syntax: Expected '(', read

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The enumerated list consists of name strings and the associated integer value. The integers should 
be enclosed in parentheses.

Possible Cause: The MIB file has invalid characters or characters between the name string and the opening 
parenthesis. 

Action: Make sure the name string is a single word and does not contain white space. 

Possible Cause: The name string may be incorrectly made up of spaces, or other white space characters. 

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space) between the name string and the integer value. 

Possible Cause: The integer value may be missing entirely, or the enclosing parentheses may be missing or 
replaced by braces. 

Action: Enclose the integer value in parentheses. 

MIBCERR106: Incorrect syntax: Expected ')', read

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The integer value should be enclosed in parentheses. The closing right parenthesis was not found.

Possible Cause: Non-numerical or non-white-space characters (characters other than the white space characters 
such as tab or space) are present between the integer and the closing parentheses. 

Possible Cause: The closing parenthesis for the integer value is missing.

Possible Cause: The value has non-numerical invalid characters inserted between digits.

Action: Ensure that there are no non-white-space characters between the integer value and that the closing 
parenthesis is present.

Possible Cause: Using the symbol "|" in the following statement, comprised of a number followed by a range of 
numbers, is not supported by the MIB Compiler:

SYNTAX INTEGER(0|3..10)

However, it does parse a number followed by a number.

Action: The Results window of the MIB Compiler points out occurrence of the error by extending the MIB 
file name and the line number. Open the specified MIB in an editor and rectify the error at the 
mentioned line number.

For the example above, you would replace the statement in the MIB with the following: 

SYNTAX INTEGER(0..10) 

Remove the symbol "|" from the statement, save the changes, and compile the MIB.

MIBCERR107: Incorrect syntax: Expected ',' or '}'

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The possible lists are either an enumerated list or a variable list. The lists should be made up of list 
items, enclosed within opening and closing braces, and commas are used to separate the list items. 
This error is declared when this format is not present. 

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present between the list items and the separating comma.
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Possible Cause: The closing brace is missing. 

Action: Delete any non-white-space characters between items in the list or between the last item and the 
closing braces. Separate list items with commas.

MIBCERR108: Incorrect syntax: Expected '{' after DEFVAL

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: DEFVAL defines a predefined value for a variable. The value to be used should be enclosed within 
opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present between the DEFVAL and the opening brace. 

Action: Delete any non-white-space characters. Enclose characters within opening and closing braces.

MIBCERR109: Incorrect syntax: Expected '{' after VARIABLES

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The VARIABLES keyword is followed by a list of object names in the MIB. The names should be 
separated by commas and enclosed within opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present between the VARIABLES keyword and the opening braces.

Action: Delete any non-white-space characters. 

Possible Cause: The opening brace is missing. 

Action: Enclose characters within opening and closing braces.

MIBCERR110: Incorrect syntax: Expected '{', read

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The SEQUENCE keyword is followed by a list of items making up a sequence. Each item of the 
list is made up of an object name and an object value pair. The list items should be separated by 
commas and enclosed within opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present between the SEQUENCE keyword and the opening brace.

Action: Delete any invalid characters between the SEQUENCE keyword and the opening brace.

Possible Cause: The opening brace is missing entirely. 

Action: Make sure that the opening brace is not missing. 

MIBCERR111: Incorrect syntax: Expected a non-negative integer

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros.

Possible Cause: The specified integer value is incorrect.

Action: Check that the integer value is expressed in the expected format. 
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MIBCERR112: Incorrect syntax: Expected a type

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The type can either be a built-in standard SMI type or a user-defined type. 

Possible Cause: The type does not refer to a built-in standard SMI type or a user-defined type.

Action: Ensure that the type is of the expected format.

Possible Cause: The type does not refer to a built-in standard SMI type or a user-defined type. Apart from these 
expected types, the compiler does not parse IMPLIED usage in the following statement. 

INDEX { ifIndex, caqClassifierAclType, IMPLIED caqClassifierAclName }

The IMPLIED modifier to an object name is an optional usage in SNMPv2 convention for the 
INDEX clause. The IMPLIED keyword enables a small savings in the instance identifier when one 
of the index objects is a variable string.

Action: The Results window of the MIB Compiler points out occurrence of the error by extending the MIB 
file name and the line number. Open the specified MIB in an editor and rectify the error at the 
mentioned line number. 

For the example above, you would replace the statement in the MIB with the following: 

INDEX { ifIndex, caqClassifierAclType, caqClassifierAclName }Remove the IMPLIED variable 
from the statement, save the changes and compile the same MIB. Because it is an optional usage, 
ignoring it would have no impact on the functionality.

MIBCERR113: Incorrect syntax: Expected an integer

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros and a sign 
(optional). White space can exist between the sign and the digits.

Possible Cause: The specified integer value is incorrect.

Action: Ensure that the integer value is expressed in the expected format. 

MIBCERR114: Incorrect syntax: Expected an octet string

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The string should be enclosed in quotes. It can be standard text (alphanumerical with punctuation 
characters), binary string (0s and 1s), or hexadecimal string (all digits, A,B,C,D,E,F, a, b, c, d, e, f).

Possible Cause: The required string is not present.

Action: Ensure that the string is provided and is expressed in the expected format.

MIBCERR115: Incorrect syntax: Expected a filename after HELP

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The HELP clause is optional. The HELP keyword should be followed by a filename, which is used 
for the alarm system on the ZENworks for Servers console. 

Possible Cause: The expected filename is missing after the HELP keyword.

Action: Check that a filename is provided after the HELP keyword.
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MIBCERR116: Incorrect syntax: Expected HELPTAG number after #HELPTAG

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The integer number corresponds to the appropriate offset in the online help file named in the HELP 
clause.

Possible Cause: No number was found after the HELPTAG keyword.

Action: Delete the non-negative integer after the HELPTAG keyword. 

Possible Cause: The number was not in the expected integer format. 

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space).

MIBCERR117: Incorrect syntax: Expected identifier after ACCESS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The ACCESS clause defines the access levels in terms of identifiers. The identifiers can be:     

Read-only 

Read-write 

Write-only 

Not-accessible 

Possible Cause: The keyword in the ACCESS clause does not belong to the defined set. 

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space). Specify a valid identifier.

MIBCERR118: Incorrect syntax: Expected identifier after STATUS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The STATUS clause defines the implementation support required for this object using identifiers. 
The supported values are:

MANDATORY, OPTIONAL (support is mandatory or optional) 

DEPRECATED (must be supported, but may be removed from the next version) 

OBSOLETE (the managed nodes no longer need to support this object) 

Possible Cause: The identifier is absent completely. 

Action: Specify a valid identifier.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present between the STATUS and the identifier. 

Action: Delete any non-white-space characters. 

Possible Cause: The keyword in the OBJECT clause may not be a valid identifier.

Action: Specify a valid identifier.

Action: Delete any non-white-space characters.
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MIBCERR119: Incorrect syntax: Expected identifier

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The TRAP-TYPE macro contains either an enumerated list or a variable list. The list should be 
made up of items separated with commas and enclosed within opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present before the name.

Action: Delete any non-white-space characters between the list items.

Possible Cause: The name was not found. 

Action: Enclose list items within opening and closing braces, without any invalid non-white-space 
characters.

Possible Cause: An identifier after the GROUP clause is not present. 

Action: Specify a valid identifier. Delete non-white-space characters.

MIBCERR120: Incorrect syntax: Expected index object or index type

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The INDEX clause contains a list of object names separated by commas. The list of object names 
should be enclosed within opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present.

Action: Delete any non-white-space characters in the clause. 

Possible Cause: The Index Object type or Index type is not the name of an object in the MIB.

Action: Express names in the proper format. 

MIBCERR121: Incorrect syntax: Expected module reference

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: When the MIB Compiler applies strict ASN.1 syntax, by convention, the module names should 
begin with an uppercase letter.

Possible Cause: The name of the module starts with a lowercase letter. 

Action: Ensure that the module name begins with an uppercase letter. 

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space).

MIBCERR122: Incorrect syntax: Expected number

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros and a sign 
(optional). White space can be between the sign and the digits.

Possible Cause: The integer value is incorrect. 

Action: Ensure that the integer value is expressed in the expected format.
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MIBCERR123: Incorrect syntax: Expected a string after DESCRIPTION

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The DESCRIPTION clause has a quoted string, which is the description for that particular object 
in the MIB.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string quoted to avoid confusion with the closing quote. 

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present before the beginning of the string. 

Action: Ensure that non-white-space characters do not precede the string.

MIBCERR124: Incorrect syntax: Expected string after REFERENCE

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The REFERENCE clause has a quoted string, which is the description for that particular object in 
the MIB.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing quote.

Possible Cause: Non-white-space characters are present before the beginning of the string.

Action: Ensure that non-white-space characters do not precede the string. 

MIBCERR125: Incorrect trap annotation: Expected string after SUMMARY

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The SUMMARY clause has a quoted string, which is the description for that particular object in 
the MIB.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing quote. 

Possible Cause: Non-white-space (characters other than the white space characters such as tab or space) may be 
present before the beginning of the string. 

Action: Ensure that non-white-space characters do not precede the string. 

MIBCERR126: Incorrect trap annotation: Expected string after TYPE

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: In the TRAP-TYPE macro, the TRAP TYPE clause has a quoted string, which is the description 
for that particular trap in the MIB.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing quote. 
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Possible Cause: Non-white-space characters may be present before the beginning of the string. 

Action: Ensure that non-white-space characters do not precede the string. 

MIBCERR127: Incorrect trap annotation: Expected time index number after \#TIMEINDEX

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros and a sign 
(optional). White space can exist between the sign and the digits.

Possible Cause: The non-negative integer value is incorrect or is not present.

Action: Check that the integer value is expressed in the expected format. 

MIBCERR128: Incorrect syntax: In INDEX clause: Expected ... , INTEGER OPTIONAL

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The OPTIONAL keyword signifies that the preceding term in the INDEX clause is not mandatory. 
It must be the last term in the clause and must be preceded by an INTEGER only.

Possible Cause: The OPTIONAL keyword is not the last term in the INDEX clause. 

Action: Ensure that the keyword is the last term in the clause. 

Possible Cause: The OPTIONAL keyword is preceded by a type other than INTEGER. 

Action: Ensure that the term preceding the OPTIONAL keyword is INTEGER. Delete any invalid non-
white-space characters (characters other than the white space characters such as tab or space).

MIBCERR129: Incorrect syntax: Expected ::=

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The symbol ::= has multiple uses, such as in object definitions, textual conventions, and 
demarcation of MIB modules. 

Possible Cause: The ::= symbol is missing. 

Action: Ensure that the expression has the correct form. This is important for object definitions when 
macros are being used.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present between the previous term and the ::= symbol. 

Action: Delete any non-white-space characters in the expression. 

MIBCERR130: Incorrect syntax: Expected ACCESS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: In ASN.1 syntax, the ACCESS keyword forms part of the OBJECT-TYPE macro, which defines 
the access level of that particular object.

Possible Cause: The ACCESS keyword is missing. 

Action: Ensure that the ACCESS keyword is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present in the place of the ACCESS keyword. 

Action: Delete any non-white-space characters. 
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MIBCERR131: Incorrect syntax: Expected BEGIN

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The ASN.1 syntax notation allows for objects to be defined within a separate module. A MIB file 
can contain one or more modules. These modules, by definition, begin with module_name 
DEFINITIONS::=BEGIN.

Possible Cause: The BEGIN keyword is missing.

Action: Ensure that the BEGIN keyword is present. Delete any invalid non-white-space characters 
(characters other than the white space characters such as tab or space).

MIBCERR132: Incorrect syntax: Expected DEFINITIONS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The ASN.1 syntax notation allows for objects to be defined within a separate module. A MIB file 
can contain one or more modules. These modules, by definition, begin with module_name 
DEFINITIONS::=BEGIN.

Possible Cause: The DEFINITIONS keyword is missing.

Action: Ensure that the DEFINITIONS keyword is present. Delete any invalid non-white-space characters 
(characters other than the white space characters such as tab or space).

MIBCERR133: Incorrect syntax: Expected ENTERPRISE

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The ENTERPRISE keyword forms part of the TRAP-TYPE macro and describes to which 
ENTERPRISE the trap belongs. The ENTERPRISE is usually the group that defines that particular 
MIB.

Possible Cause: The ENTERPRISE keyword is missing. 

Action: Ensure that the ENTERPRISE keyword is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present in the place of the ENTERPRISE keyword.

Action: Delete any non-white-space characters before the ENTERPRISE keyword. 

MIBCERR134: Incorrect syntax: Expected HELPTAG item after HELP

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The HELPTAG and HELP items form part of the trap definition. The item HELP defines the Help 
files to be used for the alarm system on the console. The HELPTAG refers to a particular offset in 
that file, pertaining to this particular trap.

Possible Cause: The HELPTAG item is not present. 

Possible Cause: The keyword has been spelled incorrectly or is not present. 

Action: Ensure that the keyword is present and is spelled correctly. 

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present.

Action: Delete any non-white-space characters between the two items. 
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MIBCERR135: Incorrect syntax: Expected NULL

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The MIB Compiler understands the following ASN.1 types:           

INTEGER

OBJECT IDENTIFIER

OCTET STRING

It also has built-in support for the following standard SMI types: 

Counter 

Gauge 

TimeTicks 

NetAddress

IPAddress

Opaque

Possible Cause: Attempting to use an undefined type results in this error.

Action: Ensure that the type is one of those supported by the MIB Compiler and is spelled correctly. Delete 
any invalid non-white-space characters (characters other than the white space characters such as 
tab or space).

MIBCERR136: Incorrect syntax: Expected identifier after STATUS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The STATUS keyword forms part of the OBJECT-TYPE macro, defining the implementation 
support required for that particular object, whether it is Mandatory, Optional, Deprecated, or 
Obsolete.

Possible Cause: The STATUS keyword is missing. 

Action: Ensure that the STATUS keyword is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present in the place of the STATUS keyword. 

Action: Delete any non-white-space characters.

MIBCERR137: Incorrect syntax: Expected SYNTAX

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: In ASN.1 syntax, the SYNTAX keyword forms part of the OBJECT-TYPE macro, defining the 
format of the value taken by the object.

In SNMP Version 2 syntax, the SYNTAX keyword forms part of the OBJECT-TYPE and 
TEXTUAL-CONVENTIONS macro, describing any of these types.

Possible Cause: The SYNTAX keyword is missing. 

Action: Ensure that the SYNTAX keyword is present.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present in the place of the SYNTAX keyword. 

Action: Delete any non-white-space characters.
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MIBCERR138: Incorrect syntax: Expected ',' or FROM

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The FROM keyword refers to objects defined in other MIB modules.

Possible Cause: The FROM keyword is missing or is spelled incorrectly.

Action: Check that the keyword is present and is spelled correctly.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present where the word was expected. 

Action: Delete any non-white-space characters.

MIBCERR139: Incorrect syntax: Import clause: Expected symbol

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: Terms defined in other MIB modules can be referenced with the IMPORT clause. Only identifiers, 
types, and object identifiers can be used with the IMPORT clause.

Possible Cause: The term present in the IMPORT clause is neither an identifier nor a type.

Action: Check that the items with the IMPORT clause are either identifiers or types. Standard SMI macros 
such as OBJECT-TYPE and TRAP-TYPE can also be imported.

MIBCERR140: Illegal type in IndexPart

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: In an INDEX clause, the following types of objects are supported:

Integers 

Octet strings 

Object identifiers

Net addresses

IP addresses

Possible Cause: The type may is not one of those supported by the INDEX clause.

Action: Ensure that the types of the objects named in the INDEX clause are supported by the INDEX 
clause.

MIBCERR141: Out of memory

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: This error occurs when the operating system is incapable of supplying required memory to this 
application.

Possible Cause: There are too many active applications.

Action: Close some open applications. Retry the operation. You may need to shut down and restart the 
operating system.
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MIBCERR142: Premature end of file encountered. HINT: Check for premature truncation of file (%s)

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The end of the file was reached while the compilation was in an incomplete state. Each MIB source 
file contains one or more modules. Each module contains related object definitions. If the end of 
the file was found before the MIB Compiler finished compiling the current module, this error is 
generated. 

The END keyword, which denotes the end of a MIB module, must be found before the end of the 
file occurs. 

Possible Cause: The file may be truncated or is incomplete.

Action: Check that the MIB source file was not truncated or incomplete by checking the original version. 
If the file was downloaded from the Internet, it may be incomplete. You must download the file 
again.

MIBCERR143: A syntax error encountered in the object ID

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The object ID may be in the form of the name of the node, by itself, or with references to its 
parents, in their named form. For example, the following are allowed:

dodiso(1) org (3) dod (6)

Possible Cause: The object ID may be improperly formed or is nonexistent.

Action: Ensure that the object ID is correctly formed. Delete any invalid non-white-space characters 
(characters other than the white space characters such as tab or space).

MIBCERR144: Token too large

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The MIB Compiler sets a limit on the largest size that it can handle. This limit is based on the 
review of many existing MIB source files, and is designed to handle most strings. 

Possible Cause: The word that the MIB Compiler is currently considering is too large to be handled.

Action: Specify a shorter name.

MIBCERR147: Incorrect alarm trap annotation: Too many arguments after ARGUMENTS.

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: There is a limit on the number of arguments that can be declared.

Possible Cause: There are too many arguments declared after the ARGUMENTS keyword.

Action: Ensure that the number of arguments does not exceed the maximum number of arguments allowed.

MIBCERR148: Undefined identifier

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: Each MIB module is made up of a collection of definitions of objects that make up a portion of the 
MIB tree. Each definition relates the current definition to some other existing object in the MIB. 
Either the referred object is defined within the same MIB, or it is referenced from an external 
module using the IMPORT statement.
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Possible Cause: The identifier is not be defined in the current MIB. 

Action: Ensure that the referred identifier has been spelled correctly and the referred identifier exists 
within the module.

Possible Cause: The identifier is not correctly imported from the appropriate MIB, or the spelling may be incorrect. 

Action: Ensure that the referred identifier is referenced correctly from an external module using the 
IMPORT statement, and that the MIB is being compiled. 

Action: Delete any invalid non-white-space characters (characters other than the white space characters 
such as tab or space) where the identifier is expected.

Action: Ensure that the identifier is included in the MIB in which it is accessed, or is included among the 
imported MIBs.

MIBCERR149: Undefined type

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: Each MIB module is made up of a collection of definitions of objects that make up a portion of the 
MIB tree. Each definition includes some type information. ASN.1 provides basic types, but user-
defined types can be added. These types are either defined within the same MIB, or else they are 
referenced from an external module using the IMPORT statement.

Possible Cause: The type is not be defined in the current MIB. 

Action: Ensure that the referred type exists within the module. 

Possible Cause: The type is not correctly imported from the appropriate MIB.

Action: Ensure that the referred type is referenced correctly from an external module using the IMPORT 
statement, and that the MIB is being compiled. 

Possible Cause: The spelling is incorrect.

Action: Ensure that the referred type has been spelled correctly,

Action: Delete any invalid non-white-space characters (characters other than the white space characters 
such as tab or space) where the identifier is expected. 

MIBCERR150: Undefined IMPORTS:

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: Identifiers and types may be referenced from other MIB modules using the IMPORT statement. 
This error is generated if a module named in the IMPORT statement is missing.

Possible Cause: The MIB source file is not available for compilation.

Action: The MIB source file containing the referenced MIB module is being compiled currently. It should 
be present in the MIB Server Pool. 

Possible Cause: The name of the module is missing or is incorrectly spelled.

Action: Ensure that the name of the module is spelled correctly.

Action: Ensure that invalid non-white-space characters (characters other than the white space characters 
such as tab or space) are not present in the name.
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MIBCERR151: Redefinition of

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: There is a single namespace for the symbols being defined in each MIB module of the MIB tree. 
This means that there cannot be more than one object of the same name in the same MIB module.

Possible Cause: This name is used for some other identifier or type in the MIB module. 

Action: Ensure that there are no other occurrences of the name in the MIB.

MIBCERR152: Unexpected term

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The definition of an object should be terminated with the following: 

::= {reference to parent MIB tree child number} 

The reference to the parent can either be qualified as the name of the parent, or in terms of its 
parents. 

For example, the following would be accepted: 

::= {iso org(3) dod (6) 1}

The child number describes the object being described in terms of its parent, as in the first child of 
parent node dod.

Possible Cause: The child number of the node being defined is not found. 

Possible Cause: The reference to the parent token is incorrect. 

Action: Ensure that the reference to the parent is correct, and that the child number is unique to the parent.

MIBCERR153: Invalid token

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The MIB Compiler allows only the following characters for use in names: alphanumeric and 
underscore ([a-zA-Z0-9_]). These characters can occur in any order.

Possible Cause: The word contains invalid characters.

Action: Ensure that the word used is made up only of valid characters.

MIBCERR154: Unexpected type after SEQUENCE OF

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The SEQUENCE OF keywords must be followed by a type name, which defines the objects in the 
SEQUENCE.

Possible Cause: The SEQUENCE OF keywords were not followed by a type name or were followed by an invalid 
type name.

Action: Ensure that a valid type name occurs after the SEQUENCE OF keywords.

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space).
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MIBCERR155: Unrecognized ASN.1 type after SYNTAX

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The name referenced by the SYNTAX clause should define the abstract syntax for the object, 
either in terms of the universal types or user-supplied types.

Possible Cause: The type referenced after the SYNTAX command was not found.

Action: Ensure that the type referenced in the SYNTAX clause is either a universal type or a user-defined 
type.

Action: Delete any non-white-space characters after the SYNTAX keyword.

MIBCERR156: Unrecognized value for SEVERITY

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The standard annotations for the TRAP-TYPE macro include a field for SEVERITY. This field can 
include any of the following four defined values:

CRITICAL

MAJOR

MINOR

INFORMATIONAL

Possible Cause: The value listed after the SEVERITY keyword is not one of the four defined values.

Action: Ensure that the value for SEVERITY is one of the four defined values. 

MIBCERR157: Print operation cancelled, either due to operator cancel or operation cannot be 
completed

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: This error is generated when the user interrupts the printing or when the printer is unable to execute 
the command. 

Possible Cause: The printer is not connected. 

Possible Cause: The printer is offline.

Possible Cause: The user canceled the command. 

Action: Correct the printer problem and issue the command again.

MIBCERR158: Incorrect syntax: Expected a string after DISPLAY-HINT 

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The DISPLAY-HINT clause has a quoted string, which is the description for that particular object 
in the MIB.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. Double quote (" ") any quotes in the string to avoid confusion 
with the closing quote.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present before the beginning of the string. 

Action: Delete any non-white-space characters before the string. 
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MIBCERR201: Incorrect syntax: Expected a string after UNITS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The UNITS clause defines the units for the OBJECT-TYPE, such as minutes and seconds.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. Double quote (" ") any quotes in the string to avoid confusion 
with the closing quote.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present before the beginning of the string.

Action: Delete any non-white-space characters before the string. 

MIBCERR205: Incorrect syntax: Expected OBJECTS 

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The OBJECTS keyword forms part of the OBJECT-GROUP and NOTIFICATION-TYPE macro, 
defining the members of the group.

Possible Cause: The OBJECTS keyword is missing.

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space) before the OBJECTS keyword. Ensure that the OBJECTS keyword is present.

MIBCERR212: Incorrect syntax: Expected LAST-UPDATED

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: In the MODULE-IDENTITY macro, the LAST-UPDATED clause describes the date and time 
when the module was last updated. The date and time are expressed in universal time format 
(UTC).

Possible Cause: The LAST-UPDATED keyword is missing.

Action: Ensure that the LAST-UPDATED keyword is present. 

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space) before the LAST-UPDATED keyword. 

MIBCERR213: Incorrect syntax: Expected a string after LAST-UPDATED

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The LAST-UPDATED clause has a quoted string, which contains the date and time expressed in 
universal time format (UTC).

Possible Cause: The enclosing quotes for the string are missing.

Action: Enclose the string within quotes. Double quote (" ") any quotes in the string to avoid confusion 
with the closing quote.

Possible Cause: Invalid non-white-space characters (characters other than the white space characters such as tab or 
space) are present before the beginning of the string. 

Action: Delete any non-white-space characters before the string. 
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MIBCERR214: Incorrect syntax: Expected ORGANIZATION

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The ORGANIZATION clause gives the name of the organization that created the module.

Possible Cause: The ORGANIZATION keyword is missing.

Action: Ensure that the ORGANIZATION keyword is present. 

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space) between the quoted string after LAST-UPDATED and ORGANIZATION. 

MIBCERR215: Incorrect syntax: Expected string after ORGANIZATION

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The ORGANIZATION clause has a quoted string, which gives the name of the organization that 
created the module.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing quote. 

Possible Cause: Invalid non-white-space characters (characters other than the white space characters such as tab or 
space) are present before the beginning of the string. 

Action: Delete any non-white-space characters before the string. 

MIBCERR216: Incorrect syntax: Expected a string after CONTACT-INFO

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The CONTACT-INFO clause has a quoted string, which gives the information about the contact 
for any queries for this MIB module.

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. Double quote (" ") any quotes in the string to avoid confusion 
with the closing quote.  

Possible Cause: Invalid non-white-space characters (characters other than the white space characters such as tab or 
space) are present between the quoted string after the ORGANIZATION and CONTACT-INFO 
keywords.

Action: Delete any non-white-space characters between the quoted string after the ORGANIZATION and 
CONTACT-INFO keywords. 

MIBCERR217: Incorrect syntax: Expected a string after REVISION

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The REVISION clause has a quoted string, which is the date and time expressed in universal time 
format (UTC).

Possible Cause: The enclosing quotes for the string are missing. 

Action: Enclose the string within quotes. Double quote (" ") any quotes in the string to avoid confusion 
with the closing quote.
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Possible Cause: Invalid non-white-space characters (characters other than the white space characters such as tab or 
space) are present between the quoted string after the CONTACT-INFO keyword and the 
REVISION keyword.

Action: Delete any non-white-space characters between the quoted string after the keywords CONTACT-
INFO and REVISION. 

MIBCERR218: Incorrect syntax: Expected CONTACT-INFO

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The CONTACT-INFO keyword forms part of the MODULE-IDENTITY macro, and gives the 
information about the contact for any queries for this MIB module.

Possible Cause: The CONTACT-INFO keyword is missing.

Action: Ensure that the CONTACT-INFO keyword is present. 

Action: Delete any non-white-space characters (characters other than the white space characters such as 
tab or space) before the CONTACT-INFO keyword. 

MIBCERR219: Incorrect syntax: Expected DESCRIPTION

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: In ASN.1 syntax, the DESCRIPTION keyword forms part of the OBJECT-TYPE macro, defining 
the implementation support required for that particular object, whether it be Mandatory, Optional, 
Deprecated, or Obsolete. 

In SNMP Version 2 syntax, the DESCRIPTION keyword forms part of the OBJECT-TYPE, 
TEXTUAL-CONVENTION, OBJECT-IDENTITY, NOTIFICATION-TYPE, OBJECT-
GROUP, and MODULE-IDENTITY macros, describing any of these types. 

Possible Cause: The DESCRIPTION keyword is missing. 

Action: Ensure that the DESCRIPTION keyword is present.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present in the place of the DESCRIPTION keyword.

Action: Delete any non-white-space characters.

MIBCERR221: Incorrect sequence adopted to define trap annotation. Correct sequence is: TYPE, 
SUMMARY, ARGUMENTS, SEVERITY, TIMEINDEX, HELP, HELPTAG and STATE

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The sequence you have adopted to write the trap annotations is incorrect. MIB Compiler is unable 
to compile the Trap annotations and produce the output to the Alarm Management System.

Possible Cause: The expected sequence of writing the trap annotations is violated.

Action: You must write the trap annotations in the following order:

1. TYPE

2. SUMMARY

3. ARGUMENTS

4. SEVERITY

5. TIMEINDEX
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6. HELP

7. HELPTAG

8. STATE

MIBCERR226: Incorrect Syntax: Expected identifier after OBJECTS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The OBJECT -GROUP macro is one of the four macros which forms a part of the conformance 
statement of SNMPv2 specification. The OBJECTS clause lists all the objects contained in the 
conformance group. 

Possible Cause: The identifiers to be declared after the OBJECTS clause are missing.

Action: Specify a valid identifier following the OBJECTS clause.

Action: If you have specified the identifier, check for any existing non-white spaces (for example: tab or 
blank space) between the OBJECT clause and the identifier and delete them.

MIBCERR227: Incorrect syntax: Expected NOTIFICATIONS

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The NOTIFICATIONS -GROUP macro is a part of the four macros of the conformance statements 
for SNMPv2 specification. The NOTIFICATIONS clause identifies all the notifications.

Possible Cause: The NOTIFICATIONS keyword is missing.

Action: Specify the NOTIFICATIONS keyword.

Action: If you have specified the NOTIFCATIONS keyword, check for any existing non-white spaces (for 
example: tab or blank space) before the NOTIFCATIONS keyword and delete them.

MIBCERR228: Incorrect syntax: Expected identifier after NOTIFICATIONS 

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The NOTIFICATIONS -GROUP macro is a part of the four macros of the conformance statements 
for SNMPv2 specification. The NOTIFICATIONS clause identifies lists all the notifications 
contained in the conformance group.

Possible Cause: The identifiers to be declared after the NOTIFICATIONS clause are missing

Action: Specify a valid identifier following the NOTIFICATIONS clause.

Action: If you have specified the identifier, check for any existing non-white spaces (for example: tab or 
blank space) between the NOTIFICATIONS clause and the identifier and delete them

MIBCWAR001: Unrecognized ACCESS type

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The ACCESS clause defines the access levels in terms of identifiers. The following identifiers can 
be included: 

Read-only 

Read-write 

Write-only
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Not-accessible

Possible Cause: The identifier is not found. 

Action: Specify a valid identifier.

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
may be present between ACCESS and the identifier.

Action: Delete any non-white-space characters.

MIBCWAR002: Unrecognized STATUS type

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The STATUS keyword forms part of the OBJECT-TYPE macro, defining the implementation 
support required for that particular object, whether it be Mandatory, Optional, Deprecated, or 
Obsolete. 

Possible Cause: The term to define the STATUS is not recognized.

Possible Cause: The term is spelled incorrectly.

Action: Ensure that the term is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters such as tab or space) 
are present where this word was expected.

Action: Delete any invalid non-white-space characters.

MIBCWAR003: Ignoring named number > 32767

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The MIB Compiler works with the largest integer that can be represented as 32767. If a named 
number occurs that has a value larger than 32767, the MIB Compiler generates this error.

Possible Cause: The value of the named number is greater than that which can be represented on this machine. 

Action: Ensure that numbers used in named number lists are correctly listed with values less than 32767.

MIBCWAR004: Trap(s) missing supplemental NMS annotation

Source: ZENworks for Servers; Management and Monitoring Services; MIB Compiler

Explanation: The definition of the TRAP-TYPE macro requires supplemental information, in the following 
form:

–#TYPE "FileSys: Directory write err (no vol)" 

–#SUMMARY "Error occurred writing to "–#SUMMARY "extended directory space on server 
%s." 

–#ARGUMENTS {0}

–#SEVERITY CRITICAL

–#TIMEINDEX 1

–#HELP "nwalarm.hlp"

–#HELPTAG 2

–#STATE DEGRADED
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These annotations are used by the Alarm Manager System of ZENworks for Servers.
IMPORTANT: These annotations are prefixed with –#, and are ignored by other compilers incapable of 
understanding them. However, they are relevant to this MIB Compiler and should not be removed or mistaken 
as comments because these annotations start with a dash (–).

Possible Cause: The standard defined trap annotation is missing.

Action: Ensure that the annotations are present for the TRAP-TYPE definitions and that they have 
meaningful values.

Traffic Analysis Error Messages
Add protocol operation failed
Unable to reach the agent
Unable to turn to promiscuous mode
Console views display abnormal values for segment bandwidth utilization.\
Constraints in addition of new protocols
Constraints in addition of new protocols
Insufficient rights to modify protocol attributes
Interface driver not loaded
Interface error
Interface not found
Interface is not licensed
Irrecoverable error
Multiple refreshes to some views during early cycles of discovery
ZfS server is not responding
The media is not supported
MIB-2 not found
No SNMP Response
No statistics
Not a promiscuous driver
Not a raw send driver
Pipelined adapter
Remove protocol operation failed
RMON is not present on the switch
RMON2 service is not available on this node
SNMP / Console error displayed by LSM
SNMP Error
The switch is not responding
Table(s) not found
This segment does not have an RMON Agent connected to it

Add protocol operation failed

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: This error is displayed if the addition of a protocol to the Protocol Directory fails.

Possible Cause: The agent may not allow certain protocols to be added.

Action: Add only the protocols that the agent allows you to add.
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Possible Cause: An internal error occurred at the agent.

Action: If this error occurs multiple times, unload and reload the agent.

Possible Cause: The ZfS server is not responding.

Action: Restart the ZfS server.

Unable to reach the agent

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: This message displays if the management server is down or if the connection between the agent 
and the management server is down.

Action: Ensure that the management server is up and running and check the connection between the agent 
and the server.

Unable to turn to promiscuous mode 

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The Traffic Analysis Agent requires promiscuous mode to function appropriately. 

Possible Cause: The Traffic Analysis Agent software failed to turn on the promiscuous mode for the interface.

Possible Cause: The board or the driver is not functioning.

Possible Cause: The server where the traffic analysis agent is installed is running out of resources. 

Action: Try unloading the promiscuous mode driver and reloading it. If that does not solve the problem, 
see the driver's documentation or “Resolving Server Memory Problems” on page 51 for details.

Console views display abnormal values for segment bandwidth utilization.

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: One of the parameters in calculating the bandwidth utilization is the interface speed (ifSpeed in 
MIB-2 RFC1158). On some NICs, the ifSpeed may not reflect the actual value because of some 
problem in querying the driver. The following drivers have this problem:

3Com* EtherLink* PCI (NT server)3Com Fast EtherLink 3C59X  (NetWare server)

Action: Upgrade to the latest drivers.

Constraints in addition of new protocols

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The agent does not allow the user to add new protocols over certain encapsulations like ETHER2, 
ETHER2.IP, ETHER2.IPX.NCP. However, new protocols can be added over ETHER2.IP.UDP, 
ETHER.IP.TCP or ETHER2.IPX.

Action: None.

Insufficient rights to modify protocol attributes

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: You do not have the rights to perform operations on the Protocol directory.

Action: Contact your system administrator regarding granting of rights.
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Interface driver not loaded

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The Traffic Analysis Agent requires an interface driver to start monitoring segments, nodes, or 
devices on your network.

Action: Load the interface driver at the agent.

Interface error

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The appropriate driver is not loaded or the driver is not loaded properly.

Action: Load the appropriate driver or check to make sure that the driver has been loaded successfully.

Interface not found

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The management console is unable to find a particular interface on the server where the monitoring 
agent is loaded. 

Possible Cause: The LAN driver for the adapter related to this interface is not loaded.

Action: If the LAN driver is not loaded, load it. You can use the Remote Console utility in the management 
console to access the server console session. Refer to the vendor documentation for information 
about what command to enter to load the driver. 

Possible Cause: The network board was removed from the server where the monitoring agent is loaded or 
exchanged for a new one.

Action: If you removed or changed a network board, wait until NetExplorer completes its next cycle and 
NetExplorer Manager runs on the management console. NetExplorer will detect that a network 
board is removed or changed and update the ZfS database accordingly.

Possible Cause: A new server is added to the network on which the monitoring agent is loaded, and it is assigned 
an IPX or IP address that has been used previously.

Action: If you assigned a previously used IP or IPX address to a new server, reassign an IP or IPX address 
that was not assigned previously and run NetExplorer and NetExplorer Manager.

Action: Update the relevant Network Interface card information using the Database Object Editor. Edit the 
existing Network Interface card information and add the Network Interface card information 
again. Do the following:

1 From ConsoleOne, select the node, which has the Network Interface card problem. 

2 Select Tools > Database Object Editor > Edit.

3 Select the Interfaces tab.

4 From the Interface Summary list, select the row which contains the interface information that 
needs to be modified > Click Edit. 

5 Change the information of the Network Interface card

6 Click Add to add the new Network Interface card information. 

7 Click OK.
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Interface is not licensed

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The installed driver is not licensed. 

Action: Load a licensed driver.

Irrecoverable error

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: An unknown error occurred when the management console tried to obtain information from the 
server where the monitoring agent is loaded. 

This error will not occur under typical conditions.

Action: If other management consoles on the segment are able to communicate with the monitoring agent, 
this indicates that the agent is functioning. Try to free memory on the management console.

If no other management console can communicate with the agent, try to free memory on the agent 
as follows:

Refer to “Resolving Server Memory Problems” on page 51 for more information on how to 
resolve memory problems on a server.

Try restarting the management console.

Multiple refreshes to some views during early cycles of discovery

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Possible Cause: During early cycles of discovery, many new nodes are discovered and nodes are moved from one 
segment to another. Because of this there may be multiple refreshes to some views.

Action: Wait for the discovery to stabilize and then launch the view.

ZfS server is not responding

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The Management server needs sufficient memory to respond to requests from the management 
console.

Possible Cause: The server is down.

Action: Ensure that the server is up and running.

Possible Cause: The server is out of memory.

Action: Restart the server if it is out of memory. For details, refer to “Resolving Server Memory Problems” 
on page 51.

Possible Cause: There is a network error in communicating with the Management server.

Action: Check the network connections and try again.

The media is not supported

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The selected medium is not supported by the monitoring agent.

Action: Use an adapter of the supported media type.
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MIB-2 not found

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: MIB-2 is the information base within where the RMON agent resides.

Action: Reload the agent.

No SNMP Response

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The machine is not on the network.

Action: Try to ping to some other hosts from Windows* NT*. If they do not respond, contact your system 
administrator.

Explanation: SNMP will not respond if the SNMP service for Windows NT is not running.

Action: Start the SNMP service. At the Management server prompt, enter net start snmp.

Explanation: The SNMP service on Windows NT is not configured.

Action: Check the community string of SNMP for READ/WRITE access.

Explanation: The NetWare servers with default settings for SNMP Set operations do not respond to the 
community string PUBLIC, although the same is not true for SNMP Get operations. As a result, 
the LSM operations that involve setting SNMP entries, like Stations and Dashboard (top n) and 
Capture packets will display no SNMP response.

Action: Set the community string to PUBLIC.

No statistics

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Possible Cause: The monitoring agent is not running on the segment. The interface cannot be monitored because 
the driver is not supported. 

Possible Cause: You disabled monitoring on the agent. 

Possible Cause: You deleted the statistics entry on the agent. 

Action: If you are running the Traffic Analysis Agent for NetWare 1.0/1.1/1.2, upgrade to version 1.3, 
which is available as part of ZfS or on the Novell Support Connection® (http://support.novell.com) 
Web page.

Install a promiscuous mode driver for the interface on the server. The driver must also support the 
raw send feature. Check the web page for information regarding availability of the latest 
promiscuous mode drivers. You might have to contact your adapter vendor for the appropriate 
driver.

If a promiscuous driver already exists, try unloading the driver and reloading it. If that does not 
solve the problem, refer to “Resolving Server Memory Problems” on page 51 for details. 

Not a promiscuous driver

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The Traffic Analysis Agent requires promiscuous mode to function properly. 

Possible Cause: The driver is not a promiscuous mode driver.
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Action: Install a promiscuous mode driver on the server. Check the Novell Support Connection (http://
support.novell.com) web page for information regarding availability of the latest promiscuous 
mode drivers. You might have to contact your adapter vendor for the appropriate driver. 

Not a raw send driver

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The Traffic Analysis Agent requires an adapter driver that supports the raw send feature. 

Possible Cause: The driver does not support the raw send feature. 

Action: Install on the server an adapter driver that supports the raw send feature. Check the Novell Support 
Connection (http://support.novell.com) Web page for information regarding availability of the 
latest promiscuous mode drivers that support the raw send feature. You might have to contact your 
adapter vendor for the appropriate driver. 

Pipelined adapter

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The Traffic Analysis Agent supports non-pipelined adapters. 

Possible Cause: The adapter is a pipelined adapter. 

Action: If the adapter allows you to switch from pipelined mode to non-pipelined mode, do so. If the 
adapter cannot switch modes, replace the adapter with an adapter of the supported media type for 
Traffic Analysis Agent operations. 

Remove protocol operation failed

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: This error is displayed if deletion of a protocol to the Protocol directory failed.

Possible Cause: The agent does not allow certain protocols to be deleted.

Action: Remove only those protocols that the agent allows you to remove.

Possible Cause: An internal error occurred at the agent.

Action: If this error occurs multiple times, unload and reload the agent.

Possible Cause: The ZfS server is not responding.

Action: Restart the ZfS server.

RMON is not present on the switch

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The RMON groups are not found on the switch.

Possible Cause: The RMON groups are not loaded.

Action: Load the RMON groups.

Possible Cause: The switch does not support RMON.

Action: None.
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RMON2 service is not available on this node

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The RMON2 group is not available at the agent.

Possible Cause: Discovery has not yet discovered sufficient information about the agent.

Action: Ensure that the discovery component of ZfS is up and running. Allow it to run for a sufficient time 
to enable it to discover objects in your network.

Possible Cause: The agent does not implement the RMON2 group.

Action: None.

SNMP / Console error displayed by LSM

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Possible Cause: If the SNMP communication to the primary agent is over NCPTM, it requires the user to log into 
this server. If the authentication is not done, LSM will report an SNMP error.

Action: Select the primary agent and launch the Probe Manageability button to force the user to 
authenticate to the server. LSM will also work after this authentication.

SNMP Error

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: This message displays if an internal error occurs at the agent.

Action: If this message displays multiple times, unload and reload the agent.

The switch is not responding

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The switch is not responding to the SNMP requests or the switch may not be configured to accept 
SNMP requests from the selected host.

Action: Enable SNMP on the switch.

Action: Use the community string accepted by the switch.

Table(s) not found

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: You will not be able to view tables for an interface if the agent is not loaded.

Action: Ensure that the agent is loaded. If you are still unable to view the required information, ensure that 
the table is implemented by the agent that is used for monitoring.

This segment does not have an RMON Agent connected to it

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis 

Explanation: The segment is not an Ethernet, token ring, or FDDI ring segment, or an RMON agent is not 
installed on the segment.

"Segment Not Monitored" has the same meaning as this message.
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Action: If you want the Ethernet, token ring, or FDDI ring segment to be monitored, install the Traffic 
Analysis Agent for NetWare or the Traffic Analysis Agent for Windows NT on a server on the 
segment.

Resolving Server Memory Problems

To free up server memory temporarily (until you can add more memory to the server), do one or 
more of the following: 

Use the FILER or the ConsoleOne utility to purge deleted files on the specified directory that 
cannot be purged automatically. (Deleted files are using up directory table space.).

Use the REMOVE DOS or the SECURE CONSOLE commands to free the memory in the 
server that was reserved for DOS.

Unload NetWare Loadable ModuleTM (NLM) file programs, such as INSTALL or MONITOR, 
that are not currently needed.

Dismount volumes that are not being used.

Reduce the size or number of volumes that the server supports.

Delete unused files and directories on the specified volume.

As a last resort, back up all files in your volume, bring down your server, and use the 
INSTALL command to reinitialize the volume. Specify a block size of 64 KB and turn the 
Block Suballocation option to OFF. (This setting uses a lot of disk space but increases the 
amount of memory available.)

Change the Minimum File Delete Wait Time SET parameter in the AUTOEXEC.NCF file so 
that files can be purged immediately rather than being retained in a salvageable state on the 
volume. 

For servers running NetWare Management Agent 2.1: 

1 Select View > All > NetWare File Servers.

2 Double-click the specific server.

3 Select Configure > Set NetWare Server Parameters.

4 Select the File System parameter.

5 Change the parameter so that files can be purged immediately by selecting the 
AUTOEXEC.NCF check box listed in the Set From section of the dialog box.

For servers running NetWare Management Agent 1.5/1.6, use Remote Console (Tools > Remote 
Console) to change server parameters.

Traffic Analysis Agent for NetWare Error Messages
After the Traffic Analysis Agent for NetWare is installed, the NE2-32.LAN driver cannot be 

loaded
After the Traffic Analysis Agent for NetWare is installed, the NE3200.LAN driver cannot be 

loaded
After the Traffic Analysis Agent for NetWare is installed, the SMART386.LAN driver cannot be 

loaded
LANZCON does not load
The LANalyzer - Adapter [MAC address] is not monitored because it is not a supported media type
Error Messages 51



    Novell Confidential                                                                                            Manual (ENU)  13 November 2003
The LANalyzer - Adapter [MAC address] is not monitored because the driver's promiscuous mode 
cannot be turned on

The LANalyzer - Adapter [MAC address] is not monitored because the Traffic Analysis Agent for 
NetWare cannot allocate memory

The LANalyzer - Ethernet adapter [MAC address] is not monitored because it is a pipelined 
adapter

The LANalyzer - Ethernet adapter [MAC address] is not monitored because the driver does not 
support promiscuous mode

The LANalyzer - Token Ring adapter [MAC address] is not monitored because it is a pipelined 
adapter

The LANalyzer - Token Ring adapter [MAC address] is not monitored because the driver does not 
support raw send

The LANalyzer - Token Ring/FDDI adapter [MAC address] is not monitored because the driver 
does not support promiscuous mode

Your server abended when you backed it up after installing the Traffic Analysis Agent for NetWare

After the Traffic Analysis Agent for NetWare is installed, the NE2-32.LAN driver cannot be loaded

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: When you installed the Traffic Analysis Agent for NetWare, the NE2-32.LAN driver was updated 
with a driver named NE2_32.LAN. Because the driver name was changed, you need to update the 
files that load drivers.

Action: Modify the files that load the adapter drivers to call the NE2-32.LAN driver, and then load the 
NE2_32.LAN driver.

After the Traffic Analysis Agent for NetWare is installed, the NE3200.LAN driver cannot be loaded

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: When you installed the Traffic Analysis Agent for NetWare, the NE3200.LAN driver was updated 
with a driver named NE3200P.LAN. Because the driver name was changed, you need to update 
the files that load drivers.

Action: Modify the files that load the adapter drivers to load the NE3200P.LAN driver.

After the Traffic Analysis Agent for NetWare is installed, the SMART386.LAN driver cannot be loaded

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: When you installed the Traffic Analysis Agent for NetWare, the SMART386.LAN driver was 
updated with a driver named MADGEODI.LAN. Because the driver name was changed, you need 
to update the files that load drivers.

Action: Modify the files that load the adapter drivers to load the MADGEODI.LAN driver.

LANZCON does not load

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: This message is displayed because of a change in the community string parameter of SNMP.
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Action: Enter the control community string as a command line parameter at the NetWare console prompt 
while loading LANZCON.

LOAD LANZCON ControlCommunity = control community string

If LANZCON is launched without any command line argument, then the default control 
community string is PUBLIC.

The LANalyzer - Adapter [MAC address] is not monitored because it is not a supported media type

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: The Traffic Analysis Agent for NetWare supports Ethernet, token ring, and FDDI, and 100BaseT 
and 100VG-AnyLAN are considered Ethernet media types. Any other adapter media types are not 
supported.

Action: Use an Ethernet, token ring, or FDDI adapter for the Traffic Analysis Agent for NetWare 
operations.

The LANalyzer - Adapter [MAC address] is not monitored because the driver's promiscuous mode 
cannot be turned on

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: The driver is corrupted or the adapter is damaged.

Action: Replace the adapter. If the problem persists, call your Novell Authorized ResellerSM.

The LANalyzer - Adapter [MAC address] is not monitored because the Traffic Analysis Agent for 
NetWare cannot allocate memory

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: The Traffic Analysis Agent for NetWare does not have adequate RAM available for it to build the 
internal data structures required to monitor the adapter.

Action: Do one or both of the following:

Unload any unnecessary NLM files

Add additional memory to your server

The LANalyzer - Ethernet adapter [MAC address] is not monitored because it is a pipelined adapter

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: A pipelined adapter is one that begins to send received data to the driver before the entire packet 
has been received. The Traffic Analysis for NetWare cannot support this method of data reception 
because it must tally all the information in a packet before the information is sent to its destination.

Action: If the adapter lets you switch from pipelined mode to non-pipelined mode, do so. If the adapter 
cannot switch modes, use a non-pipelined adapter for Traffic Analysis for NetWare transactions. 
Check the Novell Technical Services Web site (http://support.novell.com) for information 
regarding availability of the recommended adapters. You might have to contact your adapter 
vendor for the appropriate adapter.
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The LANalyzer - Ethernet adapter [MAC address] is not monitored because the driver does not support 
promiscuous mode

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: A promiscuous mode driver receives all the packets and errors on the network it is attached to. The 
Traffic Analysis Agent for NetWare requires promiscuous mode to function properly, and does not 
support non-promiscuous mode Ethernet or token ring adapters.

Action: Install a promiscuous mode driver on the server. Check the Novell Technical Services Web site 
(http://support.novell.com) for information regarding availability of the latest promiscuous mode 
drivers. You have to contact your adapter vendor for the appropriate driver.

The LANalyzer - Token Ring adapter [MAC address] is not monitored because it is a pipelined adapter

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: A pipelined adapter begins to send received data to the driver before the entire packet has been 
received. The Traffic Analysis Agent for NetWare cannot support this method of data reception 
because it must tally all the information in a packet before the information is sent to its destination.

Action: If the adapter lets you switch from pipelined mode to non-pipelined mode, do so. If the adapter 
cannot switch modes, use a non-pipelined adapter for Traffic Analysis Agent for NetWare 
transactions. Check the Novell Technical Services Web site (http://support.novell.com) for 
information regarding availability of the recommended adapters. You might have to contact your 
adapter vendor for the appropriate adapter.

The LANalyzer - Token Ring adapter [MAC address] is not monitored because the driver does not 
support raw send

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: The Traffic Analysis Agent for NetWare requires an adapter driver that supports the raw send 
feature. An adapter driver that supports raw send allows applications to build both the header and 
data components of a frame. The driver then receives the packet and sends it to its destination.

Action: Install an adapter driver on the server that supports raw send. Check the Novell Technical Services 
Web site (http://support.novell.com) for information regarding availability of the recommended 
drivers. You might have to contact your adapter vendor for the appropriate driver.

The LANalyzer - Token Ring/FDDI adapter [MAC address] is not monitored because the driver does not 
support promiscuous mode

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: A promiscuous mode driver receives all the packets and errors on the network it is attached to. The 
Traffic Analysis Agent for NetWare requires promiscuous mode to function properly, and does not 
support non-promiscuous mode Ethernet, token ring, or FDDI adapters.

Action: Install a promiscuous mode driver on the server. Check the Novell Technical Services Web site 
(http://support.novell.com) for information regarding availability of the latest promiscuous mode 
drivers. You might have to contact your adapter vendor for the appropriate driver.
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Your server abended when you backed it up after installing the Traffic Analysis Agent for NetWare

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
NetWare

Explanation: This problem is not related to the installation process. However, some Traffic Analysis Agent for 
NetWare files were loaded and probably were open when you backed up the server. Depending on 
the backup software you use, backing up the LANZ.CFG file when it is open can abend the server.

Action: Do not back up the LANZ.CFG file when you back up the server.

Traffic Analysis Agent for Windows NT Error Messages
Adapter is not monitored because it is not a supported media type
Broadcast and multicast addresses are displayed in the stations and conversations view on the 

Console
False duplicate IP address alarm generated in a DHCP environment
Installed network adapter not listed in Network Adapters screen
Management Console reports "No Response"
NetExplorer fails to discover the Traffic Analysis Agent for Windows NT
No SNMP response
RMON tables are not listed for the selected adapter
The ordinal 6451 could not be located in the dynamic link library MFC42U.DLL

Adapter is not monitored because it is not a supported media type

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: The Traffic Analysis Agent for Windows NT supports adapters on Ethernet, FDDI ring, and token 
ring media.

Action: Use the adapter of the supported media type for Traffic Analysis Agent for Windows NT 
operations.

Broadcast and multicast addresses are displayed in the stations and conversations view on the 
Console

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: Broadcast and multicast addresses are displayed to count the number of broadcast frames per 
station.

Action: No action is required.

False duplicate IP address alarm generated in a DHCP environment

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: In a DHCP environment, the DHCP server assigns an IP address to a client when the client requests 
one. The IP address is released when the client is shut down. During the process of releasing the 
IP address to the DHCP server, the client sends a DHCPRELEASE packet. If this packet does not 
reach the DHCP server, false duplicate IP address alarms will be generated.

Action: Use LANZCON to disable generation of duplicate IP address alarms. 
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Installed network adapter not listed in Network Adapters screen

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: Installed network adapters are not listed on the Network Adapters screen if the adapter is not on a 
segment of a supported media type or if TCP/IP is not bound to the adapter.

Action: Ensure that TCP/IP is bound to the selected adapter.

Management Console reports "No Response"

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: Adapter monitoring may be disabled.

Action: Use LANZCON to enable adapter monitoring. For more information, see “Enabling or Disabling 
Network Adapter Monitoring” in “Understanding Traffic Analysis” in the Administration guide.

NetExplorer fails to discover the Traffic Analysis Agent for Windows NT

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: NetExplorer uses the Service Location Protocol (SLP) to discover the agent on a network. The 
Novell ClientTM for Windows NT supports SLP. If the Novell Client for Windows NT has not been 
installed on the agent server or workstation, NetExplorer will not be able to discover the Traffic 
Analysis Agent for Windows NT on the network.

Action: Ensure that you have installed the latest Novell Client for Windows NT.

No SNMP response

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: The machine is not on the network.

Action: Try to ping to some other hosts from Windows NT. If they do not respond, contact your system 
administrator.

Explanation: SNMP will not respond if the SNMP service for Windows NT is not running.

Action: Start the SNMP service. At the Management server prompt, enter net start snmp.

Explanation: The SNMP service on Windows NT is not configured

Action: Check the community string of SNMP for read/write access.

RMON tables are not listed for the selected adapter

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Explanation: RMON tables for a network adapter are displayed only if adapter monitoring has been enabled. 
RMON tables are not displayed if they have been deleted.

Action: Enable adapter monitoring using LANZCON. For more information, see “Enabling or Disabling 
Network Adapter Monitoring” in “Understanding Traffic Analysis” in the Administration guide.
56   Troubleshooting



    Novell Confidential                                                                                            Manual (ENU)  13 November 2003
The ordinal 6451 could not be located in the dynamic link library MFC42U.DLL

Source: ZENworks for Servers; Management and Monitoring Services; Traffic Analysis Agent for 
Windows NT

Possible Cause: The MFC42U.DLL you are currently using is an older version. 

Action: Proceed with the following steps to install the new version of MFC42U.DLL:

1 Access the Windows* NT Option Pack Web site (http://www.microsoft.com/ntserver/nts/
downloads/recommended/NT4OptPk/ntsx86dl.asp)

2 Select the appropriate language > Click Next.

3 Download the SETUP1.CAB file and extract using WINZIP* to a directory on your local 
disk.

4 Copy the MFC42U.DLL file from the downloaded directory to %systemroot%\system32 
directory. (%systemroot% is typically the C:\WINNT directory). Overwrite the 
MFC42U.DLL file if it already exists. 

5 Start the Traffic Analysis Agent console for Windows NT again.

Management and Monitoring Services Reports Error Messages
ZENworks Reporting requires Microsoft Access Data Component (MDAC) version 2.6 or later. 

You must install the recommended MDAC version
Unable to connect to the database. Ensure that the database is up and running

ZENworks Reporting requires Microsoft Access Data Component (MDAC) version 2.6 or later. You 
must install the recommended MDAC version 

Source: ZENworks for Servers; Management and Monitoring Services; Reporting

Severity: Critical

Possible Cause: The MDAC version you have installed on you Management server, is not the recommended 
version. As a minimum requirement, you must install MDAC 2.6 SP1 to run MMS reports on 
Windows NT.

Action: Check the MDAC version of the you have installed. 

1 From the desktop console, click Start > Settings > Control Panel > ODBC Data Sources.

2 Select the About tab.
The minimum version required is 3.520.7326.0 

3 Upgrade the ODBC core components if the version does not match the minimum required 
version specified. Download the MDAC 2.6 SP1 from the Microsoft Web site (http://
microsoft.com/data/download.html).

Unable to connect to the database. Ensure that the database is up and running

Source: ZENworks for Servers; Management and Monitoring Services; Reporting

Severity: Warning

Possible Cause: The MMS database is not up and running.

Action: Ensure that the MMS database is up and the MMS database is loaded on the database server.

Possible Cause: The network connection is down.
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Action: Ensure that the network connection is up.

Unable to log into the database. Ensure that the ODBC driver is installed properly

Source: ZENworks for Servers; Management and Monitoring Services; Reporting

Severity: Warning

Possible Cause: The driver provided with the ZENworks for Servers 3 Companion CD is not installed.

Action: You must install the ODBC client from the ZENworks for Servers 3 Companion CD on the 
machine. The ODBC client sybaseodbc.zip is available in the \odbc\sybase directory on the 
ZENworks for Servers 3 Companion CD. To install the ODBC driver, see <link here to the 
installing section>

Possible Cause: The driver files are copied at a location other than the default location.

Action: Do the following: 

1 Ensure that the following files are present:

c:programfiles\sybase\adaptive server anywhere 7.0\win32\dbcom7.dll
c:programfiles\sybase\adaptive server anywhere 7.0\win32\dblgen7.dll
c:programfiles\sybase\adaptive server anywhere 7.0\win32\dbodbc7.dll
c:programfiles\sybase\adaptive server anywhere 7.0\win32\dbodtr7.dll
c:programfiles\sybase\adaptive server anywhere 7.0\win32\dbport6.dll

2 If you are unable to locate the above files, install the Sybase ODBC driver again. If you are 
unable to copy the dlls to the c:\programfiles\sybase\adaptive server anywhere 7.0\win32 
directory, you must manually change the all the occurrences of the path in the Sybaseodbc.reg 
file. Double-click Sybaseodbc.reg to install the driver again.
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2 Troubleshooting Strategies

The following section provides solution to problems you might encounter when using Novell® 
ZENworks® for Servers (ZfS)3 Management and Monitoring Services:

“Troubleshooting NetExplorer” on page 59

“Troubleshooting Atlas Manager” on page 73

“Troubleshooting the Alarm Manager” on page 74

“Troubleshooting the Service Manager” on page 76

“Troubleshooting Trace Capture” on page 76

“Troubleshooting Server Management Agent” on page 77

“Troubleshooting Management and Monitoring Services Reports” on page 78

Troubleshooting NetExplorer
“My routers are not discovered” on page 60
“My router is discovered as an IP workstation” on page 61
“My servers are not discovered” on page 61
“My server is discovered as an IP workstation” on page 62
“A network segment is not discovered” on page 63
“My segments are displayed under Islands” on page 64
“The DNS names of my machines are not displayed” on page 64
“My switches are not discovered” on page 64
“My switch is discovered as an IP workstation” on page 65
“The map is consolidating and displaying the network segments” on page 66
“None of my discovery modules are running, although I did type netxplor. The status is displayed 

as Waiting in NXPCON” on page 67
“My server name is displayed as an IP address” on page 67
“I have reset the scope and restarted discovery. The machines which do not belong to the scope are 

still displayed in the Atlas” on page 67
“Discovery is trying to query machines which I do not want to be discovered” on page 68
“My machines are displayed under the wrong segment” on page 68
“The IP/IPX/MAC address information for my machine is incorrect” on page 68
“My switch has been discovered with empty address information and a name as 'Switch on 

x.x.x.x'” on page 69
“My workstations are not discovered” on page 70
“Discovery is running for a long time (many hours). The Atlas contains WAN pages and Islands 

and both are empty” on page 70
“Multiple machines with the same name are displayed” on page 71
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“My Traffic Analysis Agent is not discovered” on page 71
“My Traffic Analysis Agent is discovered as an IP workstation” on page 72
“There are machines deleted from my network, but I still view them in the Atlas” on page 72
“NetExplorer does not have access to any of the routers in my network” on page 72
“The routers in my network are managed by some other company” on page 72
“NetExplorer is successfully discovering the machines. But the map does not display the 

discovered machines” on page 72

My routers are not discovered

Possible Cause: The NXPIP module is not running.

Action: Check the status of NXPIP through NXPCON. If the NXPIP status is not set to run, set the status 
of NXPIP to run. For information, see “Choosing Which Discovery Modules to Load” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

Possible Cause: The SNMP community string of the router is not configured in NetExplorerTM.

Possible Cause: The router access control prevents the NetExplorer server from retrieving information about using 
SNMP.

Action: To validate the SNMP configuration issue or the access control issue, you need to perform the 
following tasks: 

1 From ConsoleOne®, launch the MIB Browser.

2 Enter the IP address of the router.

3 Enter the SNMP READ/GET community string.

4 Select the MIB-II system group (iso.org.dod.internet.mgmt.mib-2.system).

5 Click Tree Walk.

The results will be displayed if you have configured correctly. 

If the results are not displayed you need to configure to discover IP routers. For more information, 
see “Starting Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide. 

Possible Cause: The scope is set in such a way that the router cannot be reached from the Management and 
Monitoring Services site server.

Action: You need to set the scope. For more information, see “Changing the Discovery Scope” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide. 

Possible Cause: The Management and Monitoring Services site server is unable to reach the network where the 
router is present. For example, there might exist might be a VPN connection between the site 
server and the router.

Action: If the router cannot be reached from the site server directly, you need to perform the following task: 

1 Enter the IP addresses of the routers in the additional IP router list using NXPCON. For more 
information, see “Specifying a Seed Router and Additional IP Routers” in “Understanding 
Network Discovery and Atlas Management” in the Administration guide.
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My router is discovered as an IP workstation

Possible Cause: The NXPIP module is not running.

Action: Check the status of NXPIP through NXPCON. If the NXPIP status is not set to run, set the status 
of NXPIP to run. For information, see “Choosing Which Discovery Modules to Load” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

Possible Cause: The SNMP community string of the router is not configured in NetExplorer.

Possible Cause: The router access control prevents the NetExplorer server from retrieving information about using 
SNMP.

Action: To validate if there is any SNMP configuration issue or access control issue, you need to perform 
the following tasks: 

1 From ConsoleOne, launch the MIB Browser.

2 Enter the IP address of the router.

3 Enter the SNMP READ/GET community string.

4 Select the MIB-II system group (iso.org.dod.internet.mgmt.mib-2.system).

5 Click Tree Walk.

The results will be displayed if you have configured correctly. 

If the results are not displayed you need to configure to discover IP routers. For more information, 
see “Starting Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide. 

Possible Cause: The scope is set in such a way that the router cannot be reached from the Management and 
Monitoring Services site server.

Action: You need to set the scope. For more information, see “Changing the Discovery Scope” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide. 

Possible Cause: The Management and Monitoring Services site server is unable to reach the network where the 
router is present. For example, there might be a VPN connection between the site server and the 
router.

Action: If the router cannot be reached from the site server directly, you need to perform the following task: 

1 Enter the IP addresses of the routers in the additional IP router list using NXPCON. For more 
information, see “Specifying a Seed Router and Additional IP Routers” in “Understanding 
Network Discovery and Atlas Management” in the Administration guide.

My servers are not discovered

Possible Cause: The IPGROPER module is not running.

Action: Check if IPGROPER is running in the NetExplorer IP host discovery. If IPGROPER module is not 
running, set the module to run. For information, see “Choosing Which Discovery Modules to 
Load” in “Understanding Network Discovery and Atlas Management” in the Administration 
guide.

Possible Cause: The SNMP community string of the server is not configured for discovery.

Action: To validate your SNMP configuration, you need to perform the following tasks:

1 From ConsoleOne, launch the MIB Browser.

2 Enter the IP address of the server.
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3 Enter the SNMP READ/GET community string.

4 Select the MIB-II system group (iso.org.dod.internet.mgmt.mib-2.system).

5 Click Tree Walk.

The results will be displayed if you have configured correctly. 

If the results are not displayed you need to configure to discover IP routers. For more information, 
see “Starting Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Possible Cause: The scope set for discovery does not contain the address of the server.

Action: You need specify the address of the server in the scope. For more information, see “Changing the 
Discovery Scope” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide. 

Possible Cause: There is a problem with the address information of the server returned by SNMP.

Action: To validate your SNMP configuration, you need to perform the following tasks:

1 From ConsoleOne, launch the MIB Browser.

2 Enter the IP address of the server.

3 Enter the SNMP READ/GET community string.

4 Select the MIB-II ipAddrTable in the IP group (iso.org.dod.internet.mgmt.mib-
2.ip.ipAddrTable.ipAddrentry.ipAdEntAddr).

5 Click Tree Walk.

Check if the IP address appears in the list. Specify the correct IP address of the server. You 
need to wait until the next cycle of discovery for this address to be discovered. 

Possible Cause: The network in which the server is present is not discovered because the router connecting the 
network to the site server is not discovered.

Action: If the machines that are in the same network as the server are not discovered, then check if the 
router which is connected to the network is discovered. For more information, see “My router is 
discovered as an IP workstation” on page 61. 

If the network is very large, NetExplorer will take longer time to discover the information about 
the server.

Possible Cause: Discovery has not run for a sufficient time.

Action: If the SNMP information is correct, you can use file-based discovery to immediately obtain 
information about the machine discovered, without having to wait for discovery to reach the 
network in the normal cycles. For more information, see “File-Based Discovery” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

My server is discovered as an IP workstation

Possible Cause: The IPGROPER module is not running.

Action: Check if the IPGROPER module is running in the NetExplorer IP host discovery. If the 
IPGROPER module is not running, set the module to run. For information, see “Choosing Which 
Discovery Modules to Load” in “Understanding Network Discovery and Atlas Management” in 
the Administration guide.

Possible Cause: The SNMP community string of the server is not configured for discovery.

Action: To validate your SNMP configuration, you need to perform the following tasks:
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1 From ConsoleOne, launch the MIB Browser.

2 Enter the IP address of the server.

3 Enter the SNMP READ/GET community string.

4 Select the MIB-II system group (iso.org.dod.internet.mgmt.mib-2.system).

5 Click Tree Walk.

The results will be displayed if you have configured correctly. 

If the results are not displayed you need to configure to discover IP routers. For more information, 
see “Starting Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Possible Cause: The scope set for discovery does not contain the address of the server.

Action: You need to set the scope. For more information, see “Changing the Discovery Scope” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide. 

Possible Cause: There is a problem with the address information of the server returned by SNMP.

Action: To validate your SNMP configuration, you need to perform the following tasks:

1 From ConsoleOne, launch the MIB Browser.

2 Enter the IP address of the server.

3 Enter the SNMP READ/GET community string.

4 Then select the MIB-II ipAddrTable in the IP group (iso.org.dod.internet.mgmt.mib-
2.ip.ipAddrTable.ipAddrentry.ipAdEntAddr).

5 Click Tree Walk.

Check if the IP address appears in the list. Specify the correct IP address of the server. You 
need to wait until the next cycle of discovery for this address to be discovered. 

Possible Cause: The network where the server is present is not discovered because the router connecting the 
network to the site server is not discovered.

Action: If the machines that are in the same network as the server are not discovered, then check if the 
router that is connected to the network is discovered. For more information, see “My router is 
discovered as an IP workstation” on page 61. 

If the network is very large, NetExplorer will take a longer time to discover the information about 
the server.

Possible Cause: Discovery has not run for a sufficient time.

Action: If the SNMP information is correct, you can use file-based discovery to immediately obtain 
information about the machine discovered, without waiting for discovery to reach the network in 
the normal cycles. For more information, see “File-Based Discovery” in “Understanding Network 
Discovery and Atlas Management” in the Administration guide.

A network segment is not discovered

Possible Cause: The router connecting the network segment is not discovered.

Action: Check if the router connecting the segment is discovered. For more information, see “My router is 
discovered as an IP workstation” on page 61. 

Possible Cause: The scope is set in such a way that the network segment cannot be discovered.
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Action: You need to set the scope. For more information, see “Changing the Discovery Scope” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

Possible Cause: Discovery has not run for a sufficient time.

Action: If the network is very large, NetExplorer takes longer time to discover the information about the 
segment. You can use file-based discovery to obtain information about the machine discovered. 
For information, see “File-Based Discovery” in “Understanding Network Discovery and Atlas 
Management” in the Administration guide. 

Action: To discover the segment, install the Traffic Analysis Agent on the network segment and configure 
the agent in NXPCON. For more information, see “Specifying Traffic Analysis Agents to Be 
Queried by NXPLANZ” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide. 

My segments are displayed under Islands

Possible Cause: The router connecting to the segments is not discovered.

Action: Check if the router connecting the segments is discovered. For more information, see “My router 
is discovered as an IP workstation” on page 61. 

The DNS names of my machines are not displayed

Possible Cause: The IPGROPER module is not running.

Action: Check if IPGROPER is running in the NetExplorer IP host discovery. If IPGROPER is not 
running, configure the module to run. For information, see “Choosing Which Discovery Modules 
to Load” in “Understanding Network Discovery and Atlas Management” in the Administration 
guide.

Possible Cause: The DNS server information is not configured in the site server.

Action: If IPGROPER is running, check if the RESOLV.CFG file in the SYS:\ETC\ directory has the 
information about the DNS server that contains the DNS information. If the file does not have the 
information, configure DNS on a NetWare® server, which will in turn update this file.

Possible Cause: The machine was discovered using file-based discovery. File-based discovery does not discover 
the DNS name of the machines it discovers.

Action: Rename the machine from ConsoleOne.

My switches are not discovered

Possible Cause: The IPGROPER module is not running.

Action: Check if IPGROPER is running in NetExplorer IP host discovery. If IPGROPER is not running, 
configure the it to run. For more information, see “Choosing Which Discovery Modules to Load” 
in “Understanding Network Discovery and Atlas Management” in the Administration guide. 

Possible Cause: The bridge discovery is not running.

Action: Check if the bridge discovery is running. To check, you need to perform the following tasks:

1 Check the log files generated in the following directory: 
installvolume:\installdirectory\ZENWORKS\MMS\LOGFILES\SLOADER

2 Select the SLOADER-bignumber.TXT file, which contains the latest modified time stamp.

3 Search for the string Service Bridge Discovery started successfully. If this string does not 
exist, start the services. 
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Possible Cause: The SNMP community string of the switch is not configured in NetExplorer.

Action: You need to configure the SNMP community string. To configure, perform the following tasks:

1 From ConsoleOne, launch the MIB Browser. 

2 Enter the IP address of the switch.

3 Enter the SNMP READ/GET community string.

4 Select the MIB-II system group (iso.org.dod.internet.mgmt.mib-2.system).

5 Click Tree Walk.

If the configuration is correct, the results will be displayed. If the results are not displayed, 
you need to configure SNMP to discover SNMP devices. For more information see “Starting 
Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Possible Cause: The SNMP information about the switch is incorrect or inadequate for ZfS to discover it as a 
switch.

Action: If you have verified the SNMP configuration, check for the following SNMP information for the 
switch:

1 From ConsoleOne, launch the MIB Browser.

2 Use the MIB Browser again to select the dot1dBridge FDB table specified by the OID: 
1.3.6.1.2.1.17.4.3

3 Click Tree Walk. 

If no results are displayed, ZfS will not be able to recognize this as a switch. Check with the 
vendor of the switch to resolve the issue. Repeat Step 3 with the dot1dBridge STP table 
specified by the OID: 1.3.6.1.2.1.17.2.

Possible Cause: Discovery has not run for a sufficient time.

Action: If the network is very large, it might take time to NetExplorer to discover the information about 
the segment. If the router is not discovered due to various reasons or if discovery is taking a longer 
time to discover the router, use the file-based discovery to obtain information about the machine 
discovered.  For information, see “File-Based Discovery” in “Understanding Network Discovery 
and Atlas Management” in the Administration guide.

My switch is discovered as an IP workstation

Possible Cause: The IPGROPER module is not running.

Action: Check if IPGROPER is running in NetExplorer IP host discovery. If IPGROPER is not running, 
configure it to run. For more information, see “Choosing Which Discovery Modules to Load” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide. 

Possible Cause: The bridge discovery is not running.

Action: Check if the bridge discovery is running. To check, you need to perform the following tasks:

1 Check the log files generated in the following directory: 
installvolume:\installdirectory\ZENWORKS\MMS\LOGFILES\SLOADER.

2 Select the SLOADER-bignumber.TXT file which contains the latest modified time stamp.

3 Search for the string Service Bridge Discovery started successfully. If this string does not 
exist, start the services. 

Possible Cause: The SNMPcommunity string of the switch is not configured in NetExplorer.
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Action: You need to configure the SNMP community string. To configure, perform the following tasks:

1 From ConsoleOne, launch the MIB Browser. 

2 Enter the IP address of the switch.

3 Enter the SNMP READ/GET community string.

4 Select the MIB-II system group (iso.org.dod.internet.mgmt.mib-2.system).

5 Click Tree Walk.

If the configuration is correct, the results will be displayed. If the results are not displayed, 
you need to configure SNMP to discover SNMP devices. For more information see “Starting 
Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Possible Cause: The SNMP information about the switch is incorrect or inadequate for ZfS to discover it as a 
switch.

Action: If you have verified the SNMP configuration, check for the following SNMP information for the 
switch.

1 From ConsoleOne, launch the MIB Browser.

2 Use the MIB Browser again to select the dot1dBridge FDB table specified by the OID: 
1.3.6.1.2.1.17.4.3

3 Click Tree Walk. 

If no results are displayed, ZfS will not be able to recognize this as a switch. Check with the 
vendor of the switch to resolve the issue. Repeat Step 3 with the dot1dBridge STP table 
specified by the OID: 1.3.6.1.2.1.17.2.

Possible Cause: Discovery has not run for sufficient time.

Action: If the network is very large, it might take time for NetExplorer to discover the information about 
the segment. If the router is not discovered or if discovery is taking a long time to discover the 
router, use the file-based discovery to obtain information about the machine discovered.  For 
information, see “File-Based Discovery” in “Understanding Network Discovery and Atlas 
Management” in the Administration guide.

The map is consolidating and displaying the network segments

Possible Cause: One or more machines in the network are assigned more than one IP address and are bound to the 
same MAC address. ZfS assumes that the two networks are running on the same segment.

Action: Check the properties of the machines from ConsoleOne to see if machines having more than one 
IP address are connected to a single MAC address. You need to reconfigure the machines correctly 
and run discovery again with an empty database.
WARNING: The configuration information about alarms, health reports, etc will be lost If you copy an empty 
database. 

Possible Cause: The data (*.BTV) files in the following directory:  
installvolume:\installdirectory\ZENWORKS\MMS\NMDISK\IPCACHE are corrupted. The 
*.BTV files are temporary files, which are corrupted possibly due to a server abend.

Action: You need to perform the following tasks:

1 Stop NetExplorer.

2 Delete all the *.BTV files.
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3 Restart NetExplorer.

Possible Cause: NXPIP discovery is not running. Status is displayed as 'Not Loaded' in NXPCON

None of my discovery modules are running, although I did type netxplor. The status is displayed as 
Waiting in NXPCON

Possible Cause: NetExplorer was starting using netexplor after sloader. The following message is displayed the 
screen: Unable to remove files dat filename with path. You need to 
manually remove the files from the directory. Restart discovery.

Action: You need to perform the following tasks:

1 Stop the discovery services.

To stop the discovery services, enter stopdis.ncf at the Management server 
prompt.

The Consolidator, SN3 discovery, and Bridge discovery services will be stopped.

Wait until these services are completely stopped.

2 Start NetExplorer.

To start NetExplorer, enter netxplor.

3 Start the discovery services.

To start discovery services, enter startdis.ncf.

My server name is displayed as an IP address

Possible Cause: DNS server information has not been configured on the site server.

Possible Cause: SNMP information has not been discovered.

Possible Cause: The System name of the server has not been set.

Action: You need to perform the following tasks:

1 Enter the IP address of the server.

2 Enter the SNMP READ/GET community string.

3 Select the MIB-II variable sysName in the system group (iso.org.dod.internet.mgmt.mib-
2.system.sysName).

4 Click Tree Walk. 

If the name here is NULL or something incorrect, set the correct name and wait for discovery 
to refresh the information in its next cycle

For more information see “The DNS names of my machines are not displayed” on page 64 and 
“My workstations are not discovered” on page 70. 

I have reset the scope and restarted discovery. The machines which do not belong to the scope are 
still displayed in the Atlas

Possible Cause: The services were restarted. However, the database that was populated by prior rounds of 
discovery was used while restarting the services

The machines that have already discovered during the previous cycles of discovery will not be 
removed if ZfS services are restarted with a changed scope without resetting.
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Action: Copy the empty database and restart the services with the new scope. 
WARNING: If you copy the empty database, the configuration information about alarms, health reports, etc 
will be lost.

Discovery is trying to query machines which I do not want to be discovered

Possible Cause: The machines are reachable from the ZfS site server and therefore discovery can access them.

Action: If you want to prevent whole networks from being queried, set a discovery scope to avoid 
discovery finding out these machines. For more information, see “Changing the Discovery Scope”  
in “Understanding Network Discovery and Atlas Management” in the Administration guide.

If you want exclude certain machines from being discovered, use the SNMP No Access feature as 
described below:

1 Launch NXPCON.

2 Select Configuration Options > SNMP > Edit IP Exclusion List.

3 Specify the IP addresses of machines that you do not want to discover.

4 Save the configuration.

5 Select Activate Changes.

My machines are displayed under the wrong segment

Possible Cause: Because of over consolidation several segments are combined into a single segment.

Action: Check the properties of the machines from ConsoleOne to see if machines having more than one 
IP address are connected to a single MAC address. You need to reconfigure the machines correctly 
and run discovery again with an empty database.
WARNING: The configuration information about alarms, health reports, etc will be lost If you copy an empty 
database. 

Possible Cause: The subnet masks in the network are incorrectly configured.

Action: Check in your network if there is any machine that has been configured with an incorrect subnet 
mask and correct that machine. Wait for discovery to refresh the information in the next cycle.

Possible Cause: Incorrect subnet mask or incorrect default mask was specified for the machines discovered using 
file-based discovery.

Action: If the machines were discovered by file-based discovery, use the correct subnet mask and run file-
based discovery again.

The IP/IPX/MAC address information for my machine is incorrect

Possible Cause: The addresses have been changed after discovery has completed and discovery has not discovered 
these machines.

Action: If the addresses have changed after the first cycle of discovery is completed, it might take time to 
discover the changed information again, depending on the size of the network. Use file-based 
discovery to refresh the information immediately. For more information, see “File-Based 
Discovery” in “Understanding Network Discovery and Atlas Management” in the Administration 
guide.

Possible Cause: The addresses have been changed after discovery. The old and new addresses are displayed 
together.
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Action: Sometimes, ZfS displays both the old and new addresses of the machine together. Use Database 
Object Editor to delete the previous address of the machine.

Possible Cause: Outdated information about the machines was received from sources like a Traffic Analysis Agent 
or a router.

Action: If the machine is not SNMP-configured, it was possibly discovered because of a Traffic Analysis 
Agent. Try unloading and reloading the agent on the segment where the machine was placed 
previously. Reloading the agent will delete the old address and enable discovery to retrieve the 
new address.

Possible Cause: The SNMP information of the machine is displayed incorrectly.

Action: If the machine is SNMP-configured, check the SNMP information of the machine by performing 
the following tasks:

1 Launch the MIB Browser from the ZfS console.

2 Enter the IP address of the machine.

3 Select the MIB-II ipAddrTable in the IP group (iso.org.dod.internet.mgmt.mib-
2.ip.ipAddrTable.ipAddrentry.ipAdEntAddr).

4 Enter the SNMP READ/GET community string.

5 Click Tree Walk.

If you get any results at this stage, check if the IP address of the server appears in the list. If 
it does not, correct the IP address of the server and wait for the address to be discovered in the 
next cycle.

NOTE: You can use the Database Object Editor to edit the information. Select the Prevent Deletion by 
NetExplorer field to retain the information in the database. 

My switch has been discovered with empty address information and a name as 'Switch on x.x.x.x'

Possible Cause: The IPGROPER module is not running.

Action: Check if IPGROPER is running in the NetExplorer IP host discovery. If IPGROPER is not 
running, configure it to run. For more information, see “Choosing Which Discovery Modules to 
Load” in “Understanding Network Discovery and Atlas Management” in the Administration 
guide. 

Possible Cause: The bridge discovery is not running.

Action: Check if the bridge discovery is running. To check, you need to perform the following tasks:

1 Check the log files generated in the following directory: 
installvolume:\installdirectory\ZENWORKS\MMS\LOGFILES\
SLOADER

2 Select the SLOADER-bignumber.TXT file, which contains the latest modified time stamp.

3 Search for the string Service Bridge Discovery started successfully. If this 
string does not exist, you need to start the services. 

Possible Cause: The SNMP community string of the switch is not configured in NetExplorer.

Action: You need to configure the SNMP community string. To configure, perform the following tasks:

1 From ConsoleOne, launch the MIB Browser. 

2 Enter the IP address of the switch.

3 Enter the SNMP READ/GET community string.
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4 Select the MIB-II system group (iso.org.dod.internet.mgmt.mib-2.system).

5 Click Tree Walk.

If the configuration is correct, the results will be displayed. If the results are not displayed, 
you need to configure SNMP for discovering SNMP devices. For more information see 
“Starting Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Possible Cause: The SNMP information about the switch is incorrect or inadequate for ZfS to discover it as a 
switch.

Action: If you have verified the SNMP configuration, check for the following SNMP information for the 
switch.

1 From ConsoleOne, launch the MIB Browser.

2 Use the MIB Browser again to select the dot1dBridge FDB table specified by the OID: 
1.3.6.1.2.1.17.4.3

3 Click Tree Walk. 

If no results are displayed, ZfS will not be able to recognize this as a switch. Check with the 
vendor of the switch to resolve the issue. Repeat Step 3 with the dot1dBridge STP table 
specified by the OID: 1.3.6.1.2.1.17.2.

Possible Cause: Discovery has not run for a sufficient time.

Action: If the network is very large, it might take time for NetExplorer to discover the information about 
the segment. If the router is not discovered or if discovery is taking a long time to discover the 
router, use file-based discovery to obtain information about the machine.  For information, see 
“File-Based Discovery” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

My workstations are not discovered

Possible Cause: There is no Traffic Analysis Agent or router to provide information about the workstations.

Action: Install the Traffic Analysis Agent on the network segment and configure the agent in NXPCON. 
For more information, see “Specifying Traffic Analysis Agents to Be Queried by NXPLANZ” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

Possible Cause: Discovery is not able to reach the segment with the workstations.

Action: For more information, see “A network segment is not discovered” on page 63.

Discovery is running for a long time (many hours). The Atlas contains WAN pages and Islands and both 
are empty

Possible Cause: The NXP.INI file is corrupted and NetExplorer is unable to discover any components. 

Action: Compare the NXP.INI file in the following location: 
installvolume:\install_directory\ZENWORKS\MMS\MWSERVER\NMDISK with the NXP.INI 
file in the ZENworks for Servers product CD. If the NXP.INI file in the installation location does 
not contain information that is present in the NXP.INI file in the ZENworks for Servers product 
CD, then you need to perform the following tasks:

1 Copy the NXP.INI file from the ZENworks for Servers product CD to the following directory: 
installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\
NMDISK.
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2 Edit the NXP.INI file to contain the following section and its corresponding entry: 
[IPCACHE] PATH = installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\
NMDISK\IPCACHE\

3 Restart discovery.

Possible Cause: The server running Management and Monitoring Services is configured as an end node and no 
other routers are configured in the Seed Router/Additional IP Routers.

Action: By default, discovery requires certain routers to be accessible to start discovering the network. 
Configure the NetWare server running Management and Monitoring Services as a router and not 
as an end node. Alternatively, you can configure additional routers. For more information, see 
“Specifying a Seed Router and Additional IP Routers” in “Understanding Network Discovery and 
Atlas Management” in the Administration guide.

Action: Install the Traffic Analysis Agent on the network where you want the segment to be discovered 
and configure the agent in NXPCON. For more information, see “Specifying Traffic Analysis 
Agents to Be Queried by NXPLANZ” in “Understanding Network Discovery and Atlas 
Management” in the Administration guide. 

Multiple machines with the same name are displayed

Possible Cause: If the DNS names are being duplicated, the DNS server may return the same names for more than 
one machine.

Action: From ConsoleOne, check if the IP addresses of the machines have the same names. Check if the 
DNS server is returning the same DNS names for the different IP addresses using NSLOOKUP. 
Correct the configuration in the DNS server.

Possible Cause: If you have used Imaging to install NetWare servers, the same names will be displayed even if the 
server names have changed later.

Action: You need to perform the following tasks:

1 Enter the IP address of the server. 

2 Enter the SNMP READ/GET community string.

3 Select the MIB-II variable sysName in the system group (iso.org.dod.internet.mgmt.mib-
2.system.sysName).

4 Click Tree Walk.

If the same name is displayed for all the servers, set the correct name using the MIB Browser 
for each server and wait for discovery to refresh the information during the next cycle.

My Traffic Analysis Agent is not discovered

Possible Cause: The agent is not loaded on the servers.

Action: Ensure that the agent is loaded on the servers. For more information, see “Using the Traffic 
Analysis Agent for NetWare” or “Using the Traffic Analysis Agent for Windows NT/2000” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

Possible Cause: The agents are in a network other than the network where the Management and Monitoring 
Services site server is running. The SLP and SAP multicasts and broadcasts are stopped on the 
routers connecting the networks, so ZfS is unable to discover them.

Action: If your routers are disabled to forward multicasts or broadcasts you need to manually enter the 
agent in the discovery system. For more information, see “Specifying Traffic Analysis Agents to 
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Be Queried by NXPLANZ” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Possible Cause: The server running the LANZ agent is not discovered.

Action: For information on this scenario, see “My server is discovered as an IP workstation” on page 62.

My Traffic Analysis Agent is discovered as an IP workstation

Possible Cause: The agent is not loaded on the servers.

Action: Ensure that the agent is loaded on the servers. For more information, see “Using the Traffic 
Analysis Agent for NetWare” or “Using the Traffic Analysis Agent for Windows NT/2000” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

Possible Cause: The agents are in a network other than the network where the Management and Monitoring 
Services site server is running. The SLP and SAP multicasts and broadcasts are stopped on the 
routers connecting the networks, so ZfS is unable to discover them.

Action: If your routers are disabled to forward multicasts or broadcasts you need to manually enter the 
agent in the discovery system. For more information, see “Specifying Traffic Analysis Agents to 
Be Queried by NXPLANZ” in “Understanding Network Discovery and Atlas Management” in the 
Administration guide.

Possible Cause: The server running the LANZ agent is not discovered.

Action: The server running the LANZ agent may not be discovered. For more information, see “My server 
is discovered as an IP workstation” on page 62.

There are machines deleted from my network, but I still view them in the Atlas

Possible Cause: ZfS does not delete machines that have been removed from the network.

Action: Use the Database Object Editor to manually delete these machines.

NetExplorer does not have access to any of the routers in my network

Possible Cause: If NetExplorer does not have access to all the routers in your network, the servers and workstations 
will not be automatically discovered.

Action: In order to discover and manage your servers, use file-based discovery to obtain information about 
all the machines you want to manage.  For more information, see “File-Based Discovery” in 
“Understanding Network Discovery and Atlas Management” in the Administration guide.

The routers in my network are managed by some other company

Possible Cause: If NetExplorer does not have access to all the routers in your network, the servers and workstations 
will not be automatically discovered.

Action: In order to discover and manage your servers, use file-based discovery to retrieve information 
about all the machines you want to manage.  For more information, see “File-Based Discovery” 
in “Understanding Network Discovery and Atlas Management” in the Administration guide.

NetExplorer is successfully discovering the machines. But the map does not display the discovered 
machines

Explanation: This occurs on ZfS 3 SP1 or previous versions of ZfS 3 installed on NetWare 6 SP2 and above.
72   Troubleshooting



    Novell Confidential                                                                                            Manual (ENU)  13 November 2003
Possible Cause: The ZfS services were started using the sloader.ncf command before starting discovery NLM 
software (NETXPLOR.NCF)

Possible Cause: Discovery was stopped and started without stopping the ZfS services. On NetWare 6 SP2 or later, 
it is possible to restart NetExplorer while SLOADER is still running. Although NetExplorer is 
successfully discovering the machines, the database is not updated with the information of these 
discovered machines.

Action: Do the following:

1 Stop the Discovery services.

To stop the discovery services, enter stopdis.ncf at the Management server prompt.

The Consolidator, SN3 Discovery, and Bridge Discovery services will stop.

 Wait until these services are stopped completely.

2 Start NetExplorer

3 Start the Discovery services.

To start the discovery services, enter startdis.ncf at the Management server prompt.

Troubleshooting Atlas Manager
“I do not see any objects when I click on ZfS sites in ConsoleOne” on page 73
“I do not see the atlas when I click the site server object” on page 73

I do not see any objects when I click on ZfS sites in ConsoleOne

Possible Cause: You are not logged on to the tree that contains the ZfS site server.

Action: Log in to the appropriate tree.

Possible Cause: You are logged in as a user who does not have the appropriate role and scope assigned.

Action: Login as a user with the appropriate roles and scope assigned.

I do not see the atlas when I click the site server object

Possible Cause: The ConsoleOne snap-ins and the site server have different ZfS versions.

Action: You need to perform the following tasks:

1 Ensure that the ConsoleOne snap-ins and the site server are using the same ZfS version. The 
ZfS 2 snap-ins do not work with ZfS 3.0.2 site server, and vice versa.

2 Install the latest ZfS version of the snap-ins on the console and the latest version of the site 
server on the server and restart the processes.

Possible Cause: The site server processes are not running on the server.

Action: Restart the ZfS processes on the server. Wait for about 5-6 minutes and launch ConsoleOne again. 
If the problem persists, contact Novell Technical ServicesSM (http://support.novell.com).
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Troubleshooting the Alarm Manager
“No alarm is displayed in the Alarms view of ConsoleOne even though the alarms are in the 

database” on page 74
“A particular type of alarm is not displayed in the Alarms view” on page 74
“Alarms from a particular NetWare machine are not displayed in the Alarms view” on page 75
“Unable to receive SMTP mail notification” on page 75
“Unable to forward alarms or traps” on page 75
“Unable to launch the application” on page 75
“I recompiled the MIBs after changing the severity of a trap definition. The new severity status is 

reflected in the Alarm template but not in the Active Alarms and Alarm History. The incoming 
alarms still display the previous severity status” on page 75

No alarm is displayed in the Alarms view of ConsoleOne even though the alarms are in the database 

Possible Cause: The Alarm Manager may not have started properly.

Action: You need to perform the following tasks:

1 Open the SLOADER.LOG file in the 
installvolume:\installdirectory\ZfS\MMS\LOGFILES\SLOADER.TXT directory and search 
for the following string: Alarm Manager started successfully.

If you are unable to find this string, the Alarm Manager has not been started successfully.

2 Start SLOADER again. 

To start, enter sloader at the Management server prompt.

A particular type of alarm is not displayed in the Alarms view

Possible Cause: The archiving option and the ticker bar option are disabled in the alarm disposition.

Action: Check the disposition settings for the type of alarm and enable the archiving option and the ticker 
bar option. For more information, see “Archiving Alarm Statistics” or “Displaying a Ticker-Tape 
Message” in “Understanding Alarm Management” in the Administration guide.

Possible Cause: The system may not recognize the alarm type and the IgnoreUnknownTrap flag is set to YES in 
the following directory: installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\
PROPERTIES\ALARMMANAGER.PROPERTIES.

Action: You need to perform the following tasks:

1 From ZfS site > Properties, open the alarm templates.

Search for the alarm type in the templates. If the alarm type does not exist the Alarm Manager 
will not recognize the alarm type you have specified.

2 Set IgnoreUnknownTrap = NO in the following directory: 
installvolume:\installdirectory\ZENWORKS\MMS\MWSERVER\PROPERTIES\ALARM
MANAGER.PROPERTIES.

Add and compile the MIB into the MIB Pool, which defines this trap type. For more information, 
see “Configuring MIBs and Setting Up MIB Tools” in “Understanding Alarm Management” in the 
Administration guide.
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Alarms from a particular NetWare machine are not displayed in the Alarms view 

Possible Cause: The NMA is not running on the NetWare server or the TRAPTARG.CFG file in the SYS:\ETC\ 
directory does not contain the IP address of the ZfS site server.

Action: You need to perform the following tasks: 

1 Load NMA5.NCF on the server.

2 Open the SYS:\ETC\TRAPTARG.CFG file and ensure that the file contains an entry for the 
IP address of the ZfS site server.

Incomplete parameter is displayed while an application is being launched

Possible Cause: The arguments are incorrect because they contain spaces.

Action: Open the Launch Application disposition for the template for which the launching application 
disposition has been set. In the argument field, enclose the arguments within double quotes.

Unable to receive SMTP mail notification

Possible Cause: The disposition of SMTP mail notification is disabled. 

Action: Check the disposition settings for the Alarm template for which the SMTP mail notification is 
required. Verify that the IP address or DNS name of the SMTP mail server is correct and the SMTP 
service is up and running on the SMTP mail server.

Possible Cause: The SMTP mail server may not be running at the designated server.

Action: Start the SMTP mail service at the server with the designated IP address.

Unable to forward alarms or traps

Possible Cause: The ZfS site server may not be running or the Alarm Manager may not be running at the 
destination IP address or server name.

Action: Run the Alarm Manager component at the destination ZfS site server.

Possible Cause: The disposition for forwarded alarms or traps is disabled at the destination site server.

Action: Open the Alarm template at the destination site server and set the disposition to Archive for 
forwarded alarms or traps.

Unable to launch the application

Possible Cause: The application mentioned in the template disposition is not present at the site server or the 
application may not be present in the correct path.

Action: Verify the application name and the correct path where the application can be found.

I recompiled the MIBs after changing the severity of a trap definition. The new severity status is 
reflected in the Alarm template but not in the Active Alarms and Alarm History. The incoming alarms 
still display the previous severity status

Action: Restart the ZfS server.
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Troubleshooting the Service Manager
“Failed to stop \ "sloader" + "/" + [servicenames separated by comma] + " \: process does not 

appear to be running on \ " + ipaddress + " \” on page 76
“ZfS 3.0.2 Management and Monitoring Services are not reloaded if you upgrade a ZfS server 

from NetWare 5.1 to NetWare 6” on page 76

Failed to stop \ "sloader" + "/" + [servicenames separated by comma] + " \: process does not appear 
to be running on \ " + ipaddress + " \

Explanation: The services you are trying to stop in the Service Manager using startdis or stopdis may not 
be running. 

Action: Check if the services you are trying to stop are running. Ensure that the Naming Service is running. 
Start the Naming Service if it is not running. 

ZfS 3.0.2 Management and Monitoring Services are not reloaded if you upgrade a ZfS server from 
NetWare 5.1 to NetWare 6

Explanation: When you upgrade a NetWare 5.1 server on which ZfS 3.0.2 Management and Monitoring 
Services are running to NetWare 6, the Management and Monitoring Services might not be 
reloaded.

Possible Cause: The JVM version that is automatically installed along with NetWare 6 requires a different class 
path to load the Management and Monitoring Services.

Action: Follow these steps:

1 Stop the Management and Monitoring Services, if it is running. For more information on how 
to stop the services, see “Management and Monitoring Services” in the Administration guide.

2 Uncomment the following entries in the 
management_and_monitoring_services_installation_path\mms\mwserver\bin\mwsetenv.ncf 
file:

envset mwxbpath=ZENDATA:\$MMSDIR\lib\corba\vbjcosev.jar

envset mwxbpath=$mwxbpath;ZENDATA:\$MMSDIR\lib\corba\vbjorb.jar

envset mwxbpath=$mwxbpath;ZENDATA:\$MMSDIR\lib\corba\vbjapp.jar 

3 Restart the Management and Monitoring Services. For more information on how to start the 
services, see “Management and Monitoring Services” in the Administration guide.

Troubleshooting Trace Capture
“Unable to capture packets” on page 76

Unable to capture packets

Possible Cause: The preferred RMON agent is not properly configured for the segment. Packets are captured by 
the preferred RMON agent on the selected segment. The appropriate RMON agent must be 
selected on the segment for packet capture.

Action: Go to the segment properties page and make the machine which has access to all required packets 
the preferred RMON agent.
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Possible Cause: The READ/WRITE community strings of the agent machine and management console do not 
match. To capture packets, the community string on the agent machine and the management 
console must match.   

Action: You need to perform the following tasks:

1 Check and configure the READ/WRITE community string on the agent machine.

2 Go to the properties page for the agent machine on the management console and configure the 
same READ/WRITE community string as on the agent. 

Possible Cause: The agent machine is not accessible from the management console or the ZfS site server. The 
packets from the management console reach the agent through the ZfS site server.

Action: Check the network connection from the management console to the ZfS site server and from ZfS 
site server to the agent.

Possible Cause: The RMON agent does not have sufficient memory to capture packets.

Action: Go to the RMON home page on the agent machine in ConsoleOne and delete unnecessary 
resources to free up memory.

Troubleshooting Server Management Agent
“On a Windows NT/2000 server that does not have a name for primary partition or logical drive, 

enabling the physical and logical disk trending through using the 'diskperf -yv' command will 
abnormally terminate the SNMP service” on page 77

On a Windows NT/2000 server that does not have a name for primary partition or logical drive, enabling 
the physical and logical disk trending through using the 'diskperf -yv' command will abnormally 
terminate the SNMP service

Explanation: On Windows NT or Windows 2000 server that does not have a name for primary partition or 
logical drive, if you enable the physical and logical disk trending using the diskperf -yv 
command, and then you restart the server, the SNMP service will abnormally terminate.

Action: Do the following:

On a Windows NT server:

1 From the desktop console, click Start > Programs > Administrative Tools > Disk 
Administrator.

2 Right-click an unnamed primary partition or an unnamed logical drive > click Assign Drive 
Letter.

3 Select the Assign drive letter option.

4 Select a drive letter from the drop-down list.

5 Click OK.

6 Repeat Step 2 through Step 5 for all unnamed primary partitions or logical drives.

On Windows 2000 server:

1 From the desktop console, click Start > Settings > Control Panel.

2 Double-click Administrative Tools > Computer Management.

3 Click Storage > Disk Management.
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4 Right-click an unnamed primary partition or an unnamed logical drive > click Change Drive 
Letter and Paths.

5 Add a drive letter.

6 Click OK.

7 Repeat Step 4 through Step 6 for all unnamed primary partitions or logical drives.

Troubleshooting Management and Monitoring Services Reports
“I click on the Reporting snap-in in ConsoleOne but nothing happens” on page 78

I click on the Reporting snap-in in ConsoleOne but nothing happens

Explanation: ZENworks for Servers and ZENworks for Desktops use common reporting tools to generate 
reports. The previsous versions of ZfS and ZfD use JReport to generating reports. ZfS 3.0 or later 
and ZfD 4.0 or later use Crystal Reports or JReports depending on the report that is generated. ZfS 
3 or later versions require Policy and Distribution snap-ins to be installed to generate reports.

Possible Cause: You do not have the correct version of Policy and Distribution ConsoleOne snap-ins installed. To 
verify the correct version, from ConsoleOne, select Help > About Snapins to ensure that the 
ZENworks for Servers version 3 snap-ins is installed.  

Action: Install the correct Policy and Distribution ConsoleOne snap-ins on your management console. 

Action: Use a new ConsoleOne to manage your ZfS 3 or later versions, with only ZfS 3 or later versions 
installed. 
78   Troubleshooting



    Novell Confidential                                                                                            Manual (ENU)  13 November 2003
3 Documentation Updates

This section contains information on documentation content changes that have been made in the 
Troubleshooting guide for Management and Monitoring Services since the initial release of 
ZENworks® for Servers 3.0.2 (ZfS). The information will help you to keep current on updates to 
the documentation.

If you have purchased ZfS 3.0.2 and have not used or installed ZfS 3 or ZfS 3 SP1, you do not need 
to review this section.

All changes that are noted in this section were also made in the documentation. The documentation 
is provided on the Web in two formats: HTML and PDF. The HTML and PDF documentation are 
both kept up-to-date with the documentation changes listed in this section.

The documentation update information is grouped according to the date the documentation 
updates were published. Within a dated section, the changes are alphabetically listed by the names 
of the main table of contents sections for Management and Monitoring Services.

If you need to know whether a copy of the PDF documentation you are using is the most recent, 
the PDF document contains the date it was published on the front title page or in the Legal Notices 
section immediately following the title page.

The documentation was updated on the following dates:

“July 29, 2004” on page 80

“April 15, 2003” on page 80

“September 27, 2002” on page 81
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July 29, 2004
Updates were made to the following section. The updates are explained below.

Troubleshooting Strategies

Troubleshooting Strategies
The following updates were made in this section:

April 15, 2003
Updates were made to the following sections. The updates are explained below.

Error Messages

Troubleshooting Strategies

Error Messages
The following updates were made in this section:

Troubleshooting Strategies
The following updates were made in this section:

Location Change

“Troubleshooting 
the Service 
Manager” on 
page 76

Added the following troubleshooting entry:

“ZfS 3.0.2 Management and Monitoring Services are not reloaded if you upgrade 
a ZfS server from NetWare 5.1 to NetWare 6” on page 76

Location Change

“Discovery Error 
Messages” on 
page 13

The following error message was added to this section Unable to remove 
NetExplorer .DAT files in 
zfs_install_volume:\zfs_install_folder\ZENWORKS\MMS\MWSERVER\NMDIS
K\DAT.

“Management and 
Monitoring 
Services Reports 
Error Messages” 
on page 57

Added this section. 

Location Change

“Troubleshooting 
Management and 
Monitoring 
Services Reports” 
on page 78

Added this section.
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September 27, 2002
Updates were made to the following sections. The updates are explained below.

Error Messages

Troubleshooting Strategies

Error Messages
The following updates were made in this section:

Troubleshooting Strategies
The following updates were made in this section:

Location Change

“Traffic Analysis 
Agent for Windows 
NT Error 
Messages” on 
page 55

The following error message was added to this section: “The ordinal 6451 could 
not be located in the dynamic link library MFC42U.DLL” on page 57

“MIB Compiler 
Error Messages” 
on page 22

The following error messages was removed in this section: MIBCERR159, 
MIBCERR202, MIBCERR203, MIBCERR204, MIBCERR206, MIBCERR207, 
MIBCERR210, and MIBCERR211. 

The following error messages was added to this section:
“MIBCERR221: Incorrect sequence adopted to define trap annotation. 

Correct sequence is: TYPE, SUMMARY, ARGUMENTS, SEVERITY, 
TIMEINDEX, HELP, HELPTAG and STATE” on page 41

“MIBCERR226: Incorrect Syntax: Expected identifier after OBJECTS” on 
page 42

“MIBCERR227: Incorrect syntax: Expected NOTIFICATIONS” on page 42
“MIBCERR228: Incorrect syntax: Expected identifier after NOTIFICATIONS” 

on page 42

Location Change

“Troubleshooting 
Server 
Management 
Agent” on page 77

Added this section.
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